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Configuring the Fibre Channel Components 
Module 3 — Lab 1 

Objective 
After completing this lab, you will be able to configure all Fibre Channel 
components together to support a multiserver backup solution. 

Requirements 
To perform this lab exercise, you will need the following: 

! Minimum of two servers, with Pentium processors or later  

! Minimum of 32MB RAM (64MB is recommend) 

! 25MB of hard drive space 

! Two KGPSA host bus adapters (HBA) (switched fabric labs) or two PCI 
Fibre Channel Host Adapters (arbitrated loop labs or for Novell NetWare in a 
switched fabric environment) 

! Four GBIC-SW modules (switched fabric labs) or six GBIC-SW modules 
(arbitrated loop/NetWare labs) 

! Three multimode Fibre Channel cables 

! One Fibre Channel SAN Switch 8 or 16 (switched fabric labs) or one Storage 
Hub 12 (arbitrated loop labs) 

! One Modular Data Router 

! One 4-port keyboard/monitor switchbox  

! One monitor 

! One keyboard 

! Torx screwdriver 
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Procedure 

Installing the Fibre Channel Host Bus Adapter 

 
1. Make sure the server is powered down. 

2. Remove the cover to reveal the PCI slots. 

3. Install the host adapter into an empty PCI slot in the server. 

4. Replace the cover. 

5. Repeat steps 1 through 4 for the other server. 
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Installing the GBIC-SW Modules 
A Gigabit Interface Converter Shortwave (GBIC-SW) module can be inserted into 
any available port on the SAN Switch or Fibre Channel Storage Hub 12. 

1. Gently push one GBIC module into an available port on the SAN Switch or 
Storage Hub 12. The module will click into place. It has a built-in guide key 
that prevents you from inserting it incorrectly. 

 

! Important 
To reduce the risk of damage to the equipment, do not use excessive force 
when inserting the GBIC-SW module. 

 
2. If you are performing this exercise for an arbitrated loop environment or for a 

NetWare server, insert one GBIC module into the receptacle on the Fibre 
Channel Host Adapter. 

3. Repeat steps 1 and 2 for the second server. 

4. Install a GBIC module into the port on the Modular Data Router. 
 

 Note 
If you need to remove a GBIC-SW module from a component, press the tabs 
on either side of the module and gently pull it out of the component’s port. If a 
multimode Fibre Channel cable is attached to the GBIC-SW, disconnect the 
cable before removing the module from the port on the component. 
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Attaching a Fibre Channel Cable 

 

1. Plug one end of a multimode Fibre Channel cable into the HBA in the server. 
 

 Note 
Provide support for the installed Fibre Channel cable so that you do not create 
a bend radius of less than 3 inches. Support and route the Fibre Channel cables 
to prevent damage from sharp edges or from being crushed by nearby 
equipment. 

 
 
2. Attach the other end of the Fibre Channel cable to a module in the SAN 

Switch or Storage Hub 12. 

3. Repeat steps 1 and 2 for the other server. Unused ports or improperly seated 
GBIC-SWs will not affect the operation of the fabric or loop. The amber 
LED will remain illuminated for all “bypassed” ports that have GBIC-SWs 
present. 

 

 Note 
The amber LED will stay illuminated until the HBA driver is loaded during 
startup. 

 
 
4. Install another GBIC in the SAN Switch or Storage Hub 12. 

5. Attach a Fibre Channel cable from the GBIC in the SAN Switch or Storage 
Hub 12 to a GBIC in the Modular Data Router. This completes the lab 
exercise. 
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Installing the Fibre Channel 
Host Adapter Drivers 

Module 3 – Lab 2 

Objective 
After completing this lab, you will be able to install the Fibre Channel drivers for 
the Fibre Channel host bus adapter. 

 

Requirements 
To perform this lab exercise, you will need: 

! Hardware from previous exercise 

! Solution Kit CD for Windows 2000 driver for KGPSA HBA 

! SSD diskette for Netware 
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Procedure for Windows 2000 on a Switched Fabric 
1. Power on the server and log in. 

2. Insert the Solution Kit CD and allow it to auto-run. 

3. Click on Solution Software. 

4. Select Perform KGPSA Driver Update. 

5. Click Next. 

6. Click Fibre Channel Software Setup. 

7. Click Multi-Bus FC Switch Software. 

8. Click Next. 

9. Click Large LUN Utility. 

10. Click Next. 

11. Select Yes to restart the server and click Finish. 

Procedure for NetWare (Switched Fabric or Arbitrated 
Loop) 

1. Power on the server. 

2. Read the message about new hardware being found and press Enter. 

3. Select HP Fibre Channel Host Adapter Module (HAM) and press Enter. 

4. Select Save parameters and load driver and press Enter. 

5. From the console prompt, down the server. 

6. Check the nwserver directory to see if the nwaspi.cdm file is located in the 
directory. If the file is not in the directory, copy it there from the NetWare 
Operating System CD. 

 
Note 

Since boot order is important, you need to shut the server 
down at this point. When booting an Enterprise Backup 
Solution, you should always start at the library and work 
your way back to the server. 

 
7.     Repeat the above procedure for the second server. 
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Installing a TL891 DLT Mini-Library 
Module 3 – Lab 3 

Objective 
After completing this module, you will be able to install a TL891 DLT Mini-
Library. 

Requirements 
To perform this lab exercise, you will need the following: 

! One TL891 DLT Mini-Library with two drives 

! One VHDCI to 68HD SCSI cable  

! Two 10-inch daisy-chain cables 

! One Differential SCSI terminator 

! Two or more DLT IV tapes 

! One DLT Cleaning tape 
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Procedure 
1. Connect the power cord. 
 

!  
Warning 
Do not power up the unit until all SCSI cables are connected. 

 
2. Connect one end of a SCSI cable to the SCSI port labeled Library, and 

connect the other end to bus A on the Modular Data Router. 

3. Daisy chain the next four SCSI ports on the library using the short SCSI 
cables supplied. 

4. Place a terminator in the last SCSI port on the library to terminate the second 
DLT drive. Once you have completed this step, your cabling should look like 
the picture, below. 

 
Proper SCSI Cabling for a TL891 with Two DLT Drives 

 

5. Power on the library and wait for it to finish initializing. 

6. Press the Unlock/Open button and wait for the Locked light to turn off. 

7. Remove the tape magazine and place one or more tapes in the magazine. 

8. Repeat Step 6 to replace the magazine. 
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Initial Setup and Configuration – MSL5000 Tape 
Library 

Module 3 – Lab 4 

Objective 
After completing this module, you will be able to perform an initial setup of the 
MSL5000 tape library. 

 

Requirements 
! MSL5000 tape library  

! SCSI cables  

 

Procedure 

Physical Setup of the Tape Library 
1. Verify that the tape library is powered off. 

2. Cable the tape library as follows: 

If you are using the MSL5026 or MSL5030 tape libray, use the below 
diagram.  

For the host cable, connect the cable to the Network Storage Router if using a 
SAN configuration or to the host if using a direct attach configuration. 
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If you are using the MSL5052 or MSL5060 tape library, use the below diagram.  

For the host cables, connect the cables to the Network Storage Router if using a 
SAN configuration or to the host if using a direct attach configuration. 
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3. Verify that the power cables to the library are connected. 

4. Press the switch on the power supply to the I position. 

5. To turn on the tape library, touch the control panel in the front of the library.  

6. Wait for the POST process to complete. POST is complete when the LED 
under the control panel turns solid green. 



Designing and Implementing HP Enterprise Backup Solutions 

L3.4 – 4 Rev. 3.12 

 Control Panel Menu Navigation 
 

! Important 
If prompted for a password while navigating through the control panel, the 
default library password is 5566 . 

 

Library Status Screen 

1. After the POST , the library status screen displays. 

 

2. Selecting the hp logo causes the screen to display technical support contact 
information.  

 

3. Select Back to return to the library status screen. 
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4. Select the Mail Slot Access option. This option allows you to gain access to a 
mail slot without powering down the library. 

 

5. Press the Mail Slot icon for access.  If prompted for a password, type the 
default of 5566. 

6. Press Back to return to the library status screen. 

 

7. Select the Magazine Access option. 
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8. Select the icon for the right magazine to gain access that magazine. 

9. Remove the magazine.  Then reinsert the magazine and close the magazine 
door.   

10. What happens to the library after you close the magazine door? 

............................................................................................................................  

11. Press Back to return to the library status menu. 

 

12. Select the Status option. 
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13. Record a few slots with tapes as well as the tape drives numbers. We will 
need this information later when we try to move cartridges. 

............................................................................................................................  

14. Click Back to the return to the library status screen. 

 

15. Select the Move Media option. 

 

16. Touch the Source field. 

17. Touch Slot under Element Type. 

18. Touch the slot number with a tape, which you recorded in step 13. 

19. Touch the Destination field. 

20. Touch one of the entries under Element Type. 

21. Touch the number corresponding to the selection you made in the previous 
step. 

22. Touch Execute Move. 

23. After the movement of the cartridge completes, select Back to return to the 
library status screen. 
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24. Select the Online option.  This option allows to set the library online or 
offline. 

25. Return to the library status screen. 

 

26. Select the Power option. 

 

27. Do not power down the library at this time. 

28. Return to the library status screen. 
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29. Select the LCD Contrast Controls by pressing either the up or down arrows. 

30. Select the Menu button. This is one of most important options. For purposes 
of this lab, we will navigate through the options but make no changes. 

 

31. Select Library Options.  

 

32. Select the down arrow to view further options. 
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33. Select Back to return to the Menu screen. 

 

34. Select SCSI Options. 

 

35. Select the down arrow to view further options. 

36. Select Back to return to the Menu screen. 

 

37. Select Library Info. 
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38. Select Back to return to the Menu screen. 

 

39. Select Cartridge Map. 

 

40. Select Back to return to the Menu screen. 

41. For lab purposes, we will not explore the other options unless time permits. 
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This concludes the lab for the MSL5000 Initial Setup and Configuration. 
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Configuring the Modular Data Router 
Module 5 – Lab 1 

Objective 
After completing this lab, you should be able to complete the Fibre Channel setup 
to enable the servers to communicate with the tape library. 

Requirements 
To perform this lab exercise, you will need: 

! One serial cable 

! Modular Data Router 
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Procedure 
1. Connect one of your servers to the Modular Data Router by attaching the 

provided serial cable to the serial port on the rear panel of the tape controller 
and a serial port on the server. 

2. Power on the server and log in. 

3. Select Start → Programs → Accessories → Hyperterminal → Hyperterminal 
and enter a name for your hyperterminal session in the New Connection 
dialog box. 

4. Select an icon to represent the tape controller and click OK. 

5. The Phone Number dialog box displays. From the Connect using: pull-down 
menu, select the communications port assigned to your serial port; then click 
OK. (You might have to enter an area code.) 

6. Enter the following information in the Properties dialog box; then select OK. 

a. Bits per second (baud rate)  9600 

b. Data bits    8 

c. Parity     None 

d. Stop bits    1 

e. Flow control    None 

7. Select File → Properties → Settings and from the Emulation pull-down 
menu, select VT100 → OK. The Power-On menu should display. 

8. Power on the tape controller. 

9. Press Enter if the Power-On menu does not display on its own. 

10. Wait for the Power-On Self Test to complete. 

11. Enter showSCSIDevices and press Enter. 
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12. Make sure the three devices for your library display. 

 
 

13. Exit Hyperterminal. 

14. Power up the SAN Switch or Storage Hub 12. 

15. Restart the server and log in. 

Perform Step 16 for a switched fabric environment; perform Step 17 
for an arbitrated loop environment. 

16. When the server has restarted, click Start → Settings → Control Panel → 
SCSI Adapters. To verify that the drivers were installed correctly, double-
click Emulex LP8000, PCI-Fibre Channel Adapter → Bus 1. The drives 
should display as in the following graphic. 
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17. When the server has restarted, click Start → Settings → Control Panel → 
SCSI Adapters. To verify that the drivers were installed correctly, double-
click Compaq StorageWorks Fibre Channel Host Controllers → Bus 0. The 
drives should display as in the following graphic. 
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Configuring Selective Storage Presentation with the 
Modular Data Router 

Module 5 – Lab 2 

Objective 
After completing this lab, you will be able to configure the Modular Data Router 
for Selective Storage Presentation.   

Requirements 
To perform this lab exercise, you will need: 

! One serial cable 

! Dual-port Fibre Channel Module installed in Modular Data Router 

! The other equipment as already installed in previous labs 
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Procedure 
1. Connect a Fibre Channel cable from the switch or hub to each of the two 

ports of the Modular Data Router. 

2. Connect one of your servers to the Modular Data Router by attaching the 
provided serial cable to the serial port on the rear panel of the tape controller 
and a serial port on the server. 

3. Power on the server and log in. 

4. Select Start → Programs → Accessories → Hyperterminal → Hyperterminal 
and enter a name for your hyperterminal session in the New Connection 
dialog box. 

5. Select an icon to represent the tape controller and click OK. 

6. The Phone Number dialog box displays. From the Connect using: pull-down 
menu, select the communications port assigned to your serial port; then click 
OK. (You might have to enter an area code.) 

7. Enter the following information in the Properties dialog box; then select OK. 

a. Bits per second (baud rate)  9600 

b. Data bits    8 

c. Parity     None 

d. Stop bits    1 

e. Flow control    None 

8. Select File → Properties → Settings and from the Emulation pull-down 
menu, select VT100 → OK. The Power-On menu should display. 

9. Power on the tape controller. 

10. Press Enter if the Power-On menu does not display on its own. 

11. Wait for the Power-On Self Test to complete. 

12. At the prompt, type deleteconfig to clear previous settings from the MDR. 

AMC>deleteconfig 

 

13. Type y when asked to return settings to factory defaults. 

Are You Sure you Want to Remove All System Configurations 

and return to the Factory Default Settings? y 

 

THIS WILL ERASE ALL MAPS AND CONFIGURATIONS AND RETURN 

THIS UNIT TO THE FACTORY DEFAULTS. 

 

ARE YOU SURE? y 
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14. In order for the default settings to be restored, you must reboot the MDR after 
getting the following message: 

FACTORY DEFAULTS RESTORED. 

YOU MUST REBOOT THE SYSTEM IN ORDER FOR THE CHANGES TO 
TAKE EFFECT. 

 

15. At the prompt, type showscsidevices to display the SCSI devices the MDR 
recognizes.  

AMC>showscsidevices 

Device#   SCSI Bus#   SCSI Target ID    SCSI LUN    Port#    Slot#   Type 

   0          0              0              0         0        0     0x0C 

   1          5              1              0         5        2     0x08 

   2          5              2              0         5        2     0x01 

   3          5              3              0         5        2     0x01 

 

16. At the prompt, type showfcscsimap. 

AMC>showfcscsimap 

 

The Default Map is: 

FC LUN        SCSI Bus      SCSI Target ID      SCSI LUN     Device Type 

   0              0                0                0           0x0C 

   1              5                1                0           0x08 

   2              5                2                0           0x01 

   3              5                3                0           0x01 

 

17. To show the port World Wide ID’s corresponding to the HBAs that the 
Modular Data Router can communicate with, type showhosts.  The output 
will display the port names that are recognized by Port 1 and Port 2 of the 
Fibre Channel module of the MDR. 

AMC>showhosts 

Port Number    : 1 

World Wide Name - 

   Node Name   : 50:05:08:B3:00:10:0D:10 

   Port Name   : 50:05:08:B3:00:10:0D:11 

Source ID      : 0x011500 

Status         : Enabled 

Operation Mode : Fibre Channel Target 

 

    Host World Wide Name - 

      Host Node Name : 20:00:00:00:C9:22:DC:16 

      Host Port Name : 10:00:00:00:C9:22:DC:16 
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    AliasName : <not defined> 

    Is Currently Logged In : Yes 

    Source ID      = 0x011701 

    Operation Mode = Fibre Channel Initiator 

 

Port Number    : 2 

World Wide Name - 

   Node Name   : 50:05:08:B3:00:10:0D:10 

   Port Name   : 50:05:08:B3:00:10:0D:12 

Source ID      : 0x011300 

Status         : Enabled 

Operation Mode : Fibre Channel Target 

 

    Host World Wide Name - 

      Host Node Name : 20:00:00:00:C9:22:DC:16 

      Host Port Name : 10:00:00:00:C9:22:DC:16 

    AliasName : <not defined> 

    Is Currently Logged In : Yes 

    Source ID      = 0x011701 

    Operation Mode = Fibre Channel Initiator 

 

18. Notice that in the previous output, AliasName is <not defined> .  We will 
give the Host Port Name an AliasName to simplify commands.   

Type setalias HostPortName servername, as in the below example. 

 

AMC>setalias 10:00:00:00:C9:22:DC:16 server1 

The alias of port 10:00:00:00:c9:22:dc:16 is set to server1. 

 

19. Having created an AliasName for a port corresponding to an HBA, we will 
create a Fibre Channel LUN to SCSI Bus-Target-LUN mapping for Port 1 
and Port 2 of the Fibre Channel module of the MDR.  At the command 
prompt, type createmap AliasName (MDR)portnumber for Port 1 and Port 2. 

AMC>createmap server1 1 

A host map is created for host server1 at port 1. 

 

AMC>createmap server1 2 

A host map is created for host server1 at port 2. 
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20. At the prompt, type showfcscimap AliasName for an HBA.  By default, the 
FC-to-SCSI map for an HBA should show that Port 1 and Port 2 of the MDR 
can communicate with all tape drives.   

 

AMC>showfcscsimap server1 

 

The Host Map for Host server1 at Port 1: 

FC LUN        SCSI Bus      SCSI Target ID      SCSI LUN     
Device Type 

   0              0                0                0           
0x0C 

   1              5                1                0           
0x08 

   2              5                2                0           
0x01 

   3              5                3                0           
0x01 

 

The Host Map for Host server1 at Port 2: 

FC LUN        SCSI Bus      SCSI Target ID      SCSI LUN     
Device Type 

   0              0                0                0           
0x0C 

   1              5                1                0           
0x08 

   2              5                2                0           
0x01 

   3              5                3                0           
0x01 

 

21. Next, we will remove all mappings from server1 for port 2.  Type 
setfcscsimap server1 2 

AMC>setfcscsimap server1 2 

 

(setFcSCSIMap Usage: 

Change or add entries in FC-to-SCSI Map 

 

setFcSCSIMap [Alias] [PortNumber] ) 

 

set new entry (Y), delete entry (D), show map (S), stop (N)? d 

Fibre Channel LUN to be Deleted: 0 

Entry with FC LUN 0, SCSI Bus 0, Target ID 0, SCSI LUN 0 was 
removed! 

Fibre Channel LUN to be Deleted: 1 

Entry with FC LUN 1, SCSI Bus 5, Target ID 1, SCSI LUN 0 was 
removed! 
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Fibre Channel LUN to be Deleted: 2 

Entry with FC LUN 2, SCSI Bus 5, Target ID 2, SCSI LUN 0 was 
removed! 

Fibre Channel LUN to be Deleted: 3 

Entry with FC LUN 3, SCSI Bus 5, Target ID 3, SCSI LUN 0 was 
removed! 

Fibre Channel LUN to be Deleted: 

set new entry (Y), delete entry (D), show map (S), stop (N)? n 

 

22. To verify that all mapping from server1 to port 2 have been removed, type 
showfcscimap server1 

AMC>showfcscsimap server1 

 

The Host Map for Host server1 at Port 1: 

FC LUN        SCSI Bus      SCSI Target ID      SCSI LUN     
Device Type 

   0              0                0                0           
0x0C 

   1              5                1                0           
0x08 

   2              5                2                0           
0x01 

   3              5                3                0           
0x01 

 

The Host Map for Host server1 at Port 2: 

FC LUN        SCSI Bus      SCSI Target ID      SCSI LUN     
Device Type 

 

23. You have just implemented selective storage presentation for server1.  If you 
have other servers, simply repeat the process.  For the purpose of the rest of 
our labs, we will use only one Fibre Channel port.  Unplug one of the fibre 
cables.  Type deleteconfig.   

For load balancing the next server, server2 should have FC-to-SCSI mapping 
defined for Port 2 and none for Port 1. 
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Initial Configuration – Network Storage Router  
Module 5 – Lab 3 

 

Objective 
 

After completing this module, you will be able to perform and initial setup of the 
Network Storage Router. 

 

Requirements 
 

• Network Storage Router  

• Console Cable 

• Management PC with terminal software 

 

Procedure 

 
1. Connect the supplied console cable from the Network Storage Router to your 

server.   

2. Open a Terminal Session (such as HyperTerminal or PowerTerm) 

3. Connect to the Network Storage Router using the following terminal settings: 

• Baud Rate:  auto-detected by the Network Storage Router, can use 
9600, 19200, 38400, 57600, or 115200.  HP recommends setting the 
baud rate to 115200. 

• Data Bits 8 

• Stop Bits 1 

• Parity None 

• Flow Control None or XON/XOFF 
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4. The main menu appears.  Press 1 to enter the Configuration Menu. 

5. Press 2 to enter the Ethernet and SNMP Configuration Menu 
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6. Set the IP Address, Subnet Mask and Hostname settings to those recommended 
by your instructor.  When finished, press X to return to the Configuration 
Menu. 

7. Verify that the library is physically connected to the Network Storage Router, 
and that the NSR is physically connected to the fabric. 

8. For all servers that will share the tape library, perform the following steps: 

9. Power on the server.  The server will detect the Network Storage Router and 
prompt for a driver. 

10. Choose Search, then choose Specify a Location.  Insert the floppy disk 
provided by your instructor and type a:\cpqnsr.inf.  The server will load the 
driver for the device.   

NOTE: A driver is not necessary for the Network Storage Router to operate.  The 
cpqnsr.inf file is a null driver provided primarily to allow the unit to display 
normally in Device Manager. 

 

# This completes the initial configuration. 
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Creating Mappings with the Network Storage 
Router 

Module 5 – Lab 4 

Objective 
 

After completing this module, you will be able to create mappings using the 
graphical user interface on the Network Storage Router. 

 

Requirements 

 
! Two servers with Fibre Channel HBAs 

! Fibre Channel switch 

! Tape library 

! Network Storage Router with two or more FC ports 

 

 

Procedure 

 
1. Verify that the tape library, Fibre Channel switch, Network Storage Router, 

and servers have been powered on in that order. 

2. Ping the IP address you entered for the Network Storage Router in the previous 
lab for initial configuration of the NSR.  

3. Browse to the embedded web agent on the Network Storage Router by typing 
http://routerIPaddress, using the IP address you entered in the previous lab. 
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4. The Graphical User Interface for the NSR will appear.  From the Main Menu, 
select the Discovery option. 

5. The first time you make a selection from the main screen, you will be 
prompted to enter a username and password to determine access privileges.  
The default username is root and the default password is password.  Enter 
these when prompted. 
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6. Click the Go button located after the Perform Discovery on all Ports and Buses 
field. Verify that the changer and correct number of tape drives are discovered. 

7. Click the Mapping menu on the left MAIN MENU. The Mapping page 
displays. 
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8. The first entry under the Host column is the WWN of the Fibre Channel 
switch.  The next entries correspond to the WWNs of the Fibre Channel HBAs 
in the hosts.  The last entry corresponds to the WWN of the NSR port. We will 
perform the following custom mapping: 

FC Port 0:  port0map:  controller, changer, first tape drive 

FC Port 1:  port1map:  controller, second tape drive 

After the above maps are created, we then assign all host HBAs the port0map 
and the port1map.  This allows all hosts to access both ports while restricting 
data to the first tape drive to port 0 and data to the second tape drive to port 1. 
This helps achieve load balancing. 

9. Verify that Port 0 is listed in the purple bar near the top of the page. We will 
first create a mapping which allows access to both hosts while limiting the 
devices seen to the changer and first tape drive. If it is not, click port 0 in the 
left menu under the FC Module. 
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10. In the Add Map field, type port0map and click Add. A warning message 
displays. 

 

11. Click OK to the warning message. The new map now appears in the Select 
Map field. 
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12. Click Edit/View under Select Map. The Edit /View window for the map 
appears. 



Creating Mappings with the Network Storage Router 

Rev. 3.12 L5.4 – 7 

 

13.  In the Fill Map section, change the setting to Target/Bus and then click  Fill 
Map. 
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14. In the Delete Map Item(s) section, set the LUN to the LUN of the second tape 
drive. 
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15. Click the Delete button.  A warning message appears. 
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16. Click OK. The map should now display without the second tape drive. 

 

17. Exit the window by clicking the X in the top right corner. 
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18. In the Select Host field, select the WWN of the HBA of the first host. A 
warning message appears. 

 

19. Click OK to the warning.  Then click Edit/View under the Select Host. The 
map for the host appears. 
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20. At the bottom of the window, change the map name to port0map using the 
drop-down. 
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21. Click Modify. Close the window for the host by clicking the X in the top right 
corner. 
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22. Under the Select Host field, select the WWN of the HBA of the other host. 
Then select Edit/View. 
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23. At the bottom of the window, change the Map Name entry to port0map. 
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24. Click Modify. Close the window by clicking the X in the top right corner. 
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25. For port 0, you have now created a mapping which allows access to both hosts 
while limiting the devices seen to the changer and first tape drive. We will now 
creating a mapping for port 1, which allows access to both hosts while limiting 
the devices seen to the second tape drive. Under FC Module, click port 1. 
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26. In the purple bar at the top, verify that Port 1 is listed. In the Add Map field, 
type port1map. 
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27. Click Add. A warning message appears. 

 

28. Click OK to the warning message. The map port1map appears under the Select 
Map field. 
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29. Click Edit/View under Select Map. The Edit/View window for the map 
appears. 
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30. Under the Fill Map section, change the setting to Target/Bus using the drop-
down. Then click Fill Map. 
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31. All devices attached to the NSR should be listed.  We will delete entries so that 
only the NSR controller and second tape drive are seen for port 1. In the Delete 
Map Item(s) section, set the LUNs for deletion of the changer and first tape 
drive. 
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32. Click Delete Entry. A warning message appears. 
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33. Click OK to the warning message. The changer and first tape drive should no 
longer be listed. 

 

34. Click Remove Gaps near the top of the window to reassign the LUNs in order 
for port 1. A warning message appears. 
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35. Click OK to the warning message. The LUNs for port 1 should now be listed 
in numerical order. 

 



Designing and Implementing HP Enterprise Backup Solutions 

L5.4 – 26 Rev. 3.12 

36. Close the Edit/View window by clicking the X in the top corner. 

 

37. Under the Select Host field, select the HBA of the first host. Then click 
Edit/View. The Edit/View window appears. 
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38. At the bottom of the window, change the Map Name entry to port1map using 
the drop-down. 
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39. Click Modify. Then close the window by clicking the X in the top right corner. 
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40. Under the Select Host entry, select the WWN of the HBA of the second host. 
Then click Edit/View. The Edit/View window appears. 
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41. At the bottom of the window, change the Map Name entry to port1map. 
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42. Click Modify. Then close the window by clicking the X near the top right 
corner. 
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43. You have created mappings for both port 0 and port 1. In order for the 
mappings to take effect, you must reboot the NSR. Under the MAIN MENU in 
the left side of the page, click Reboot. 
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44. Click the Yes button and then Submit to reboot the NSR. The NSR should 
complete its reboot in a few minutes. 
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45. After the NSR has rebooted, verify that the operating system detects both tape 
drives.  If using Windows 2000, right-click My Computer > Manage > Device 
Manager.  
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Installing Data Protector 5.0 
for Windows 2000 

Module 6 – Lab 1 

 

Objective 
After completing this module, you will be able to install and configure Data 
Protector to run a backup and perform a restore of files. 
 
 

Requirements 
! Windows 2000 with Service Pack 2 or higher. 

! Fibre Channel switch 

! Network Storage Router 

! SCSI tape library 

! Two Intel-based servers with appropriate Fibre Channel host bus adapters 

Before You Install 
! Connect and configure the Fibre Channel Switch, Network Storage Router, 

and SCSI tape library.   

! Power up the tape library. 

! Power up the Fibre Channel switch. 

! Power up the Network Storage Router. 

! Power up the servers. 

! Install the appropriate driver for the Fibre Channel host bus adapters. 
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Procedure 
 

Installation 

1. Insert the CD into the CD-ROM drive and wait for the autorun option to 
display the menu. 

 
 

2. Select install data protector 5.0. The Welcome screen displays. 
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3. Click Next. The License Agreement screen displays. 
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4. Click I accept and then Next. The Customer Information screen appears. 

 

 

5. Click Next. The Installation type screen appears. 
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6. Select Cell Manager and click Next. The User Account Information screen 
displays. 

 

 

7. Type in the appropriate account and password.  Click Next. The Component 
selection screen appears. 
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8. Click Next. The Ready to Install screen displays. 

 

 

9. Click Install. The Wizard Completed screen appears. 
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10. Check Start the Data Protector Manager GUI and click Finish. The Next 
Step Wizard displays. 

 

 

11. Click Add New Clients. The Add Client Systems window displays. 

 



Designing and Implementing HP Enterprise Backup Solutions 

L6.1 – 8 Rev. 3.12 

12. In the Network tab, select the other server(s) and click Add. The Components 
and Options tabs display. 

 

13. Select Disk Agent, Media Agent, User Interface, and Manager-of-Managers 
User Interface. Click the Options tab.  
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14. Enter the appropriate account and password information.  Do not use a blank 
password.  The installation begins on the client(s). 

 

!  
WARNING 
The account must not have a blank password. 

 

 

 

15. When the installation on the other client(s) finish, the following screen 
displays.  
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16. Click OK. The Next Step Wizard displays. 

 

 

Configuration 

1. The Next Step Wizard should display. If not, select View > Next Step Wizard. 

 

 

2. Click Configuring Device. The Specify the device window displays. 
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3. At the Device Type field, click the drop down menu and select SCSI-II 
Library.  At the Device Name field, type in a name for the tape library. Click 
Next.  The specify information for the robotic window displays. 
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4. At the SCSI address of the library robotic field, select the drop down menu 
and choose the appropriate library robotic. Check Barcode reader support. 
Click Next.  The Specify the slots window displays. 
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5. Type the range of slots in the library and click Add.  Click Next. The Specify 
the media window displays. 
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6. In the Media Type field, click the drop down menu and select the appropriate 
media type for the drives in the library. Click Finish.  

 

7. Click Yes. You will need to configure the following number of drives for the 
library.  Number of drives = (number of servers) * (number drives in library)  

For this lab, we will use at least the following: 

Device name = ServerAdrive1, Drive index = 1, Lock name = drive1 

Device name = ServerAdrive2, Drive index = 2, lock name = drive2 

Device name = ServerBdrive1, Drive index = 1, lock name = drive1 

Device name = ServerBdrive2, Drive index =1, lock name = drive2 
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8. In the Device Name field, type serverAdrive1, where serverA is the server 
name of the Cell Manager. Click Next.  The Specify the data drive’s SCSI 
address window displays. 
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9. In the SCSI address of the drive field, click the drop down menu and select 
the first drive of the library. Click Next.  The media type window displays. 

 

10. Click Advanced. The Advanced Options screen appears. 
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11. Click the Other tab. Check Use Lock Name and type drive1 in the 
corresponding field. Click OK. Then click Finish.  Click Yes to create another 
drive. 

 

 

12. Repeat steps 8 through 11 for the following drives and information 

Device name = ServerAdrive2, Client = ServerA, Drive index = 2, Lock name 
= drive2 

Device name = ServerBdrive1, Client = ServerB, Drive index = 1, Lock name 
= drive1 
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        Device name = ServerBdrive2, Client = Server B, Drive index = 2, Lock name 
= drive2  

 

 

 

13. After creating the required number of drives, click No. The Next Step Wizard 
displays. 

 

 

 

14. Click Close.  Verify that the Devices & Media window displays. 
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15. In the left window, expand the items in the left window until you reach the 
Slots category. Right-click and select Barcode Scan.  After the scan 
completes, the Session Information window displays. 

 

16. Click OK. 
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17. While holding the Control key, click on the slots with tapes. Right-click and 
select Format unless the tapes have data that should not be destroyed. If the 
tapes have data, select Import instead. The media pool selection window 
displays. 
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18. Click Next. The description and location window displays. 
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19. Click Next. The additional options window displays. 

 

20. Check Force operation. Click Finish. Wait for the format process to 
complete. 
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21. After the format has completed, select View > Next Step Wizard. The Next 
Step Wizard displays. 
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22. Select Configure New Backup Specifications. The Create New Backup 
window displays. 

 

23. Double-click Blank Filesystem. The select client window displays. 
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24. Check both servers and the internal database. Click Next. The devices or 
drives window displays. 
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25. Select the library and all its drives. Click Next. The backup options window 
displays. 

 

26. Click Next.  The dates and times window displays. 
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27. Click Next.  The summaries window displays. 

 

28. Click Next. The finishing steps window displays. 
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29. You may wish to save the backup specifications, but this is not absolutely 
necessary for lab purposes. Click Start Backup. The backup type window 
displays. 

 

30. Click OK. The backup status window displays. 
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31. After the backup has completed, we will test the restore functionality.  Delete 
a directory with non-critical files. 
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32. In the top left menu, select Restore in the drop down menu.  Click on the 
appropriate client. In the right window, select the appropriate directory under 
the Source tab.  Click Restore. The Start Restore Session window displays. 
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33. Click Next. 

 

34. Click Finish. The Restore status window displays.  After the restore 
completes, verify that the deleted files have been restored. 
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This completes the lab. 
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Designing an Enterprise Backup Solution 
Module 7 — Lab 1 

Objective 
After completing these lab activities, you will be able to design an Enterprise 
Backup Solution. 

Procedure 
Use the EBS Site Survey Form and the steps discussed in the student guide to 
design an Enterprise Backup Solution for each of the following case studies. 

1. Load the site survey form from diskette or receive a hard copy from your 
instructor.  

2. Read the case study and fill out the site survey form. 

3. Using the formulas provided in the Student Guide, determine the best 
hardware solution for each customer. 

4. Create a hardware list to order the necessary Compaq equipment. 
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Case Study 1 
LingoStar is a small translation business. Their network consists of three Proliant 
6500 Servers running Microsoft Windows NT 4.0 with SP6. They use these 
servers for typical file and print activities. 

The company has been using ARCserveIT with the Open File agent to back up 
their servers to manually operated 35GB AIT tape drives. 

LingoStar has just updated their primary storage to a Compaq RAID Array 8000 
with twelve 18GB hard drives. Each server has been assigned four drives. The 
array is configured for RAID 5. 

The company would like full backups of all data on Sunday with differential 
backups made daily. LingoStar’s IS director estimates a 25% change in data per 
day. 

The IS department would like to keep all backups on separate tape sets and retain 
three full backups at all times. They will also erase the differential backups after 
three full backups. They keep five sets of differential backups. 
 
Equipment Needed  
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Case Study 2 
Rodnev Enterprises provides vending services to large sporting stadiums and 
college campuses in nine states. They run six Proliant 7000 Servers with Windows 
NT 4.0 SP6. The servers maintain a large Oracle database. 

The company has purchased Legato NetWorker Power Edition with the Storage 
Node option. 

Their primary storage is supplied by four 9GB internal drives on Smart 4250 ES 
Controllers on each server. They are running RAID 0. 

 Because of their constantly changing Oracle database, Rodnev wants full backups 
performed every day. 

 The Rodnev IS department maintains all backups on separate tape sets. They 
retain three full sets of backups at all times. 
 
Equipment Needed  
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Case Study 3 
A start-up CAD company, mchcad.com, has five ProLiant 2500 Servers running 
Windows NT 4.0 with SP6a. They are thinking about purchasing a 35/70GB DLT 
Drive for each server. The owner has used VERITAS Backup Exec in the past and 
wants to use this software in his current company. 

Primary storage for mchcad.com consists of three 9GB internal drives on the 
embedded SCSI Controllers in each server. Each server runs RAID 0. 

The servers are used to store the company’s CAD drawings. The files can be 
compressed at 3.5:1. 

The company would like full backups of all data made each Sunday with 
incremental backups made daily. They estimate a 20% change to the data each 
day. 

All backups will be kept on separate tape sets, with two full backups retained at all 
times. Incremental backups will be erased after one full backup. 
 
Equipment Needed  
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Case Study 4 
BigCo is looking for a new backup solution. The company has 32 servers running 
Windows NT 4.0 (four servers) and Tru64 UNIX (28 servers), each running 
Oracle. 

They would like to use VERITAS NetBackup to facilitate their backups. 

Primary storage for BigCo consists of four Enterprise Modular Array 12000s, each 
with 48 9GB drives running RAID 5 (six drives per server). 

The IS department would like full backups every Sunday with differential backups 
the other days of the week. They estimate a 20% change in data each day. They 
need to keep three full backups all on individual tape sets. The differential backups 
will be erased with the full backups. Two differential sets should be kept at all 
times. 

BigCo’s backup window is four hours per night (12 AM-4 AM). 
 
Equipment Needed  
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Using the HP StorageWorks Backup Sizing Tool to 
Design an EBS 

Module 7 — Lab 2 

Objective 
After completing this lab, you will be able to use the HP StorageWorks Backup 
Sizing Tool to design an Enterprise Backup Solution for Workgroup, 
Departmental, and Data Center customers. 

Procedure 
Use the EBS Site Survey Forms from the previous lab and the HP StorageWorks 
Backup Sizing Tool  to design an Enterprise Backup Solution for each of the 
following case studies. 

1. From the Start menu, select Programs → HP EBS Solution Sizer v1.41 → HP 
StorageWorks Backup Sizing Tool. 

2. Follow the prompts and use the information on the Site Survey Forms from 
the previous lab. 

3. Answer the questions found after each Case Study. 
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Case Study 1 
LingoStar is a small translation business. Their network consists of three Proliant 
6500 Servers running Microsoft Windows NT 4.0 with SP6. They use these 
servers for typical file and print activities. 

The company has been using ARCserveIT with the Open File agent to back up 
their servers to manually operated 35GB AIT tape drives. 

LingoStar has just updated their primary storage to a HP RAID Array 8000 with 
twelve 18GB hard drives. Each server has been assigned four drives. The array is 
configured for RAID 5. 

The company would like full backups of all data on Sunday with differential 
backups made daily. LingoStar’s IS director estimates a 25% change in data per 
day. 

The IS department would like to keep all backups on separate tape sets and retain 
three full backups at all times. They will also erase the differential backups after 
three full backups. They keep five sets of differential backups. 

Questions 

1. What is the elapsed time of the SSL2020TL backups? 

• Full on Sunday? 

............................................................................................................................  

• Differential on Tuesday? 

............................................................................................................................  

• Differential on Thursday? 

............................................................................................................................  

2. How many AIT tapes are required for this solution? 

............................................................................................................................  

3. For the hardware required for this solution, fill in the information requested: 

• Part number for the Modular Data Router 

............................................................................................................................  

• Part number for the two-drive SSL2020TL AIT Library 

............................................................................................................................  
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Case Study 2 
Rodnev Enterprises provides vending services to large sporting stadiums and 
college campuses in nine states. They run six Proliant 7000 Servers with Windows 
NT 4.0 SP6. The servers maintain a large Oracle database. 

The company has purchased Legato NetWorker Power Edition with the Storage 
Node option. 

Their primary storage is supplied by four 9GB internal drives on Smart 4250 ES 
Controllers on each server. They are running RAID 0. 

Because of their constantly changing Oracle database, Rodnev wants full backups 
performed every day. 

The Rodnev IS department maintains all backups on separate tape sets. They retain 
three full sets of backups at all times. 

Questions 

4. What is the elapsed time for each server’s backup? 

............................................................................................................................  

5. What is the elapsed time for all daily backups? 

............................................................................................................................  

6. Why is server #1 backup time different? 

............................................................................................................................  

7. How many tapes are required? 

............................................................................................................................  

8. For the hardware and software required for this solution, fill in the 
information requested: 

• Part number for the 8-port switch 

............................................................................................................................  

• Part number for the HBA 

............................................................................................................................  

• Part number for NetWorker Power Edition Storage Nodes for Windows 
NT 

............................................................................................................................  

• Part numbers for the Oracle Agents 

............................................................................................................................  
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Case Study 3 
A start-up CAD company, mchcad.com, has five ProLiant 2500 Servers running 
Windows NT 4.0 with SP6a. They are thinking about purchasing a 35/70GB DLT 
Drive for each server. The owner has used VERITAS Backup Exec in the past and 
wants to use this software in his current company. 

Primary storage for mchcad.com consists of three 9GB internal drives on the 
embedded SCSI Controllers in each server. Each server runs RAID 0. 

The servers are used to store the company’s CAD drawings. The files can be 
compressed at 3.5:1. 

The company would like full backups of all data made each Sunday with 
incremental backups made daily. They estimate a 20% change to the data each 
day. 

All backups will be kept on separate tape sets, with two full backups retained at all 
times. Incremental backups will be erased after one full backup. 

Questions 

9. How many tapes are required? 

............................................................................................................................  

10. What is the part number for the TL895 Tape Library? 

............................................................................................................................  

11. When will backups using the TL895 Tape Library be completed on 

• Sunday? 

............................................................................................................................  

• Daily? 

............................................................................................................................  

12. What is the part number for the Backup Exec for Windows NT Shared 
Storage Option Starter Kit? 

............................................................................................................................  
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Case Study 4 
BigCo is looking for a new backup solution. The company has 32 servers running 
Windows NT 4.0 (four servers) and Tru64 UNIX (28 servers), each running 
Oracle. 

They would like to use VERITAS NetBackup to facilitate their backups. 

Primary storage for BigCo consists of four Enterprise Modular Array 12000s, each 
with 48 9GB drives running RAID 5 (six drives per server). 

The IS department would like full backups every Sunday with differential backups 
the other days of the week. They estimate a 20% change in data each day. They 
need to keep three full backups all on individual tape sets. The differential backups 
will be erased with the full backups. Two differential sets should be kept at all 
times. 

BigCo’s backup window is four hours per night (12 AM-4 AM). 

Create four data zones so the company can grow with the equipment they 
purchase. 

Questions 

13. How many DLT libraries are required? 

............................................................................................................................  

14. How many tapes are required? 

............................................................................................................................  

15. When do backups finish on 

• Sunday? 

............................................................................................................................  

• Tuesday? 

............................................................................................................................  

• Thursday? 

............................................................................................................................  

• Saturday? 

............................................................................................................................  



Designing and Implementing HP Enterprise Backup Solutions 

L7.2 – 6 Rev. 3.12 

 

 



 

Rev. 3.12 L8.1 – 1 

Performance Assessment Tool 
Module 8 – Lab 1 

Objective 
After completing this module, you should be able to install and run Performance 
Assessment Tool (PAT) to assess primary storage performance. 

 

Requirements 
! Server running Windows 2000 Advanced Server 

! Tape library 

! Storage System (if available) 

Procedure 

Installation of PAT 
1. Double-click on the PAT12.exe file. 

 

2. Click Next on the below screen. 
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3. Select the storage you want to assess and click Next. 

 

4. Select Quick analysis and click Next. 
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5. Click Next at the below screen. 

 

6. The next screen will display the assess performance of your primary storage 
system’s transfer rate. Click Finish. 

 

This concludes the lab for PAT. 
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Installing and Using LT&T 3.0Installing and Using LT&T 3.0Installing and Using LT&T 3.0Installing and Using LT&T 3.0    
Module 9 – Lab 1 

 

Objective 
After completing this lab, you will be able to install and use the HP Library and 
Tape Tools (LT&T) to manage and troubleshoot a tape library. 

Requirements 
The requirements for this lab are the equipment used in the previous labs with the 
previous labs completed. 

! Server running Window NT/Windows 2000  

! Client running Windows 95 or higher or Windows NT 

! Internet Explorer 5.0 or later 

! Latest Windows version of HP Library and Tape Tools software (can be 
downloaded from http://www.hp.com/support/tapetools) 
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Procedure 
The lab is divided into two sections: 

! Installing the software 

! Using the software 

 

Installing LT&T 
1. Run the LT&T server installation by double-clicking on the icon on your 

desktop.  

LT&T 3.0 install.lnk  

2. The Welcome window displays.  Click on Next.  

 

 

3. Click Yes to the license agreement. 
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4. Click Next to read the “read me” file.   

 

 

 

5. Examine the components you wish to install, tick the ASPI layer, this is 
recommended because it gives LT&T  more granularity in diagnostics.   
Click Next to continue. 
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6. If install location is correct click Next.  

 

 

 
 

 

7. Click Next to accept the program name 

 

8. Click on Next to start the installation. 

 

9. The installation runs and completes. 

 

 
 

 
 

 

 

 

 

 

 

 

 

There should now be an HP StorageWorks Library and TapeTools icon on the desktop
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Using LT&T 
Note: If the ASPI driver layer has been installed it may be necessary to reboot the 
system 

1. Run from either the programs menu Start → Programs → HPStorageWorks 
Library and Tape Tools or using the LT&T icon on the desktop.  

2. The following screen is displayed. LT&T can talk to devices either by the 
inbuilt OS mini-port driver, or via the Adaptec ASPI driver layer. Using the 
min-port driver can give problems if the device is “claimed” by another 
application or is using non-standard OS drivers. In these cases choose the 
ASPI option. 

 

 

 

 

 

 

 

 

 

 

 

3. LT&T can diagnose and report on tape drives and libraries in either direct 
SCSI or Fibre Channel attach. The first thing LT&T does is perform a scan of  
any HBA’s capable of supporting SCSI protocol. A screen similar to the one 
below will be displayed. 

Examine the left hand device pane, checking the types of devices present and 
record them below: 

............................................................................................................................  

............................................................................................................................  

............................................................................................................................  

............................................................................................................................  
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4. First we will select the tape drive to analyse. Click on the Drive entry in the 
scan list to start the drive diagnostics. 

        The diagnostics are divided into 4 or 5 sections, as can be seen by the icons in 
the top right hand part of the window. 

1. Identify – gives Serial # information and drive revision levels 

2. Firmware – update firmware in the device 

Note: LT&T actively goes onto the HP support Web to check if firmware 
revisions are up to date. It is therefore recommended when LT&T is run 
the system also has external Web access if at all possible. If this is not 
possible drive and library firmware revisions can be read independently 
from http://www.hp.com/TBA 

3. Test – run actual diagnostic tests 

Note: these tests can overwrite data on tape. 

4. Support – generate a “support ticket” for HP  

Note: A support ticket reads specialist log files from the device, which HP 
engineers can use to accurately determine any problem. HP support will 
frequently ask for a “support ticket” before a device is exchanged, to 
confirm a failure symptom is real. 

5. Front Panel – used to test front panel commands on devices that support a 
front panel interface. 

Record the drive Serial # and the Firmware revision in use. 
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Drive Serial  # ……………… 

FW Rev ………………… 

  

5. Click on the firmware icon, note the warning message about not upgrading a 
tape drive in a library independently but only through the Library device. 
This is because drives in a library use different firmware levels than stand 
alone drives and LT&T will present you with the correct library drive 
firmware only when you go through the library device diagnostics. 

6. Click on the “test” icon in the top left hand corner of the screen. 

Tick the box on the drive device you wish to test in the right hand pane. 

List all the tests possible on the drive you have selected by clicking the “drop 
down box” under Test Group. 

Choose a test and follow the instructions (some tests require media to be 
loaded) – In the example below we have chosen the device analysis test. This 
will tell you if your drive FW is up to date (if external web access enabled) 
and analyze the drive logs for any gross errors. 

When the test is complete, click on the Test Results tab to see the details       
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7. Click on the + expansion icons for each category of analysis to obtain further 
details.  

Check with your instructor if there are any results or information you don’t 
understand    

8.  Click on the support icon in the top left hand of the window. Once again 
because this drive is part of a library, LT&T insists the support ticket is 
generated through the Library device since the drives behaviour is an integral 
part of the Library behaviour. 

9. Click the scan tab, then press the Re-scan button. 

This time select the Library device, and the Library diagnostics will load. 

Select the Identify icon from the list of utilities, to obtain the screen shown 
below.      
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10. Record the Library firmware revision and the Library Serial # 

Library Firmware revision  ……………………. 

 

Library Serial # ……………………………… 

 

Click the firmware icon. A warning message will appear indicating that the 
“local” firmware files do not contain the correct firmware type required. 

Depending on the Lab set-up at this point – either  

a) Go to the Web for the firmware update – if web access is enabled in the  
lab environment. 

b) Ask the instructor where on your server the correct FW download file is 
located. 
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The screen shot shows a web download onto the local server. 

Note: The “scripts” tab – LT&T also contains a scripting language which allows 
users or HP to write very specific diagnostic programs, which can also be 
downloaded via the Web. 

Once the FW files are in the correct location the firmware download program will 
recognize them and the library and drive firmware can be upgraded one module at 
a time. 

Start the firmware upgrade as shown below. 

 

 

 

 

 

 

 

 

 

 



Installing and Using LT&T 3.0 

Rev. 3.12 L9.1 – 11 

Please be aware of the following during FW upgrades. 

 

Click OK to continue. 

The Library and Drive firmware will then be successfully updated over the Fibre 
channel interface. 

 

 

11. Next we will run a Library exercise diagnostic. 

Click  Test icon and select Library exercise from the drop down list of tests. 

The test requires “scratch” media to be loaded into the mailslot of the Library 

Start the test. 
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12. Finally we will recover the support ticket from the Library. 

Select Support icon in top left hand section of window. 

Click on View Support Ticket, allow LT&T to capture the information, the 
following window will be displayed. 

An astounding array of information is captured, both from the Library and the 
tape drive, including internal firmware trace logs that can be analysed by 
firmware engineers. 

Take some time to expand the + entries to see the range of information captured in 
an HP support ticket. 

Note: support ticket can be saved to a file or E-mailed to HP support personnel 

 

 

THIS CONCLUDES THE LT&T TRAINING MODULE 
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Installing VERITAS Backup Exec 8.5 
for Windows NT 

Appendix A: Module 6 — Lab 1 

Objective 
After completing this module, you will be able to install and configure Backup 
Exec and the Shared Storage Option for Microsoft Windows NT. 
 

 Note 
Alternate labs for installing Computer Associates ARCserve 2000 and Legato 
NetWorker are available in the appendix. 

 

Requirements 
! Windows NT 4.0 with Service Pack 6. 

! For the shared database server, 300MB of free hard disk space and 128MB 
RAM are recommended. 

! For other servers on the loop, 25MB of free hard disk space is required and 
64MB RAM is recommended. 

! A minimum of 52MB of physical memory available (as shown in the 
Windows NT Task Manager) plus the file cache (20MB for File Cache and 
32MB for Backup Exec Shared Storage Database services and client). 

Before You Install 
It is important to note that the shared ADAMM and catalog databases for the 
shared storage network will reside on the first server on which the Shared Storage 
Option is installed. For best performance, the primary server should be the fastest 
server on the shared storage network that is not heavily loaded with non-Backup 
Exec activities. However, the Shared Storage Option must be locally installed at 
each server that will be sharing secondary storage devices. 
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For a Fibre Channel connected installation, additional requirements include: 

! A Fibre Channel host bus adapter (HBA) and its device drivers must be 
installed. 

! For Backup Exec to automatically configure the library hardware and 
properly associate the tape drives with the library, the Fibre Channel HBA 
must be connected to recognize all the secondary storage devices. For the 
adapter to do this, the following requirements must be met: 

• The storage hub must be connected to all the Fibre-to-SCSI bridges on 
the loop. 

• All the tape libraries must be connected to the bridges. 

• The storage hub and all tape libraries must be powered up before 
powering up the bridges. 

• The bridges must be powered up before Windows NT 4.0 loads the 
Fibre Channel driver (usually during the restart phase). 
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Procedure 
1. Insert the CD into the CD-ROM drive and wait for the autorun option to 

display the menu. 
 

 

2. Click Contents. The Contents screen displays. 
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3. Expand Backup Exec for Windows NT/2000. 

4. Select Software Installation. The Software Installation window displays. 

  

5. Click Install. The Welcome window displays. 
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6. Click Next to proceed with the installation. The Software License Agreement 
window displays. 

  
7. Click Yes to accept the terms of the agreement. The VERITAS Backup Exec 

Information window displays and provides information about the installation 
and its requirements. 
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8. After reading this information, click Next. The Installing VERITAS Backup 
Exec window displays. 

  

9. Select the Install Backup Exec Software or options on this computer icon. 
The VERITAS Backup Exec Serial Numbers dialog box displays, requesting 
your serial numbers. 
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10. Enter the Backup Exec and the Shared Storage Option serial numbers, as well 
as the serial numbers for any other options being installed. (For training 
purposes, do not enter a serial number.) Click Next. 

 

▲▲▲▲ 
Note 
A serial number is not required for Backup Exec’s fully functional evaluation 
version. However, if the Fibre Channel device drivers are not loaded, the 
Shared Storage Option will not display in the list of evaluation components. If 
installing the evaluation version, click OK when the evaluation message 
displays. 

 

If choosing to use the evaluation version of the software, the following 
Backup Exec Evaluation Information window displays. 

  

11. Click OK. The Backup Exec Install Options window displays.  
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12. Select Backup Exec, Tape Device Drivers, Enable Autoloader Support, and 
SAN Shared Storage Option and then click Next. A Question dialog box 
displays. 

  
13. Click Yes. The Start Copying Files dialog box displays. 

 
 

14. Verify the options being installed and click Next. 

The installation program starts copying files. 
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During the file copy process, if Backup Exec is being installed for the first 
time, the Service Account dialog box displays. Enter the user name, domain 
(in the From field), and password for the Service Account information that 
will be used. (For training purposes, enter Administrator as the user with no 
password or the preexisting user name and password). 

 

▲▲▲▲ 
Note 
It is recommended that the same user name and password be used on all 
Backup Exec servers and that a workgroup (or the same domain) be used to 
minimize issues with Windows NT security. 

 

  
 
 

 Note 
On all servers, log on to the local domain in the From field with Administrator 
as the user. 

 
15. Click OK. The Rights Granted notification displays. 
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16. Click OK. The Previous Backup Exec Installation screen displays. 

  
17. If this is the first installation on Backup Exec on your SAN, leave this field 

blank. Then click OK. If you have already installed Backup Exec on another 
Windows NT server on your SAN, enter the name of that server and click 
OK. The Installing Shared Storage Option window displays. 
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18. If you are installing on the server that will be the database server, select Yes 
and click Next. You will be prompted to enter the name of the share directory 
on the database server. The default of bent will work for the database server 
and for all regular Backup Exec servers. 

  

19. Enter the name of the share directory or accept the default and click Next. 
The Windows 2000/NT Device Driver Installer window displays. 
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20. Click Next. The Choose Tape Drivers window displays. 

  
21. Select Use VERITAS tape drivers for all tape devices and click Next. The 

Hardware scan window displays. 
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22. When the hardware scan is complete, click Next. The Installing VERITAS 
drivers window displays. 

  
23. When drivers installation is complete, click Next. A window indicating the 

driver installation is complete displays. 
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24. Click Finish. The Program Group window displays. 

  
25. Select Private Program Group to prohibit other accounts from accessing the 

Backup Exec client on this server, or select Common Group to allow other 
users to run the Backup Exec client from this server. For training purposes, 
select Private Program Group and click Next. When the installation 
completes, the Setup Complete screen displays. 

  



Installing VERITAS Backup Exec 8.5 for Windows NT 

Rev. 3.12 A – 15 

26. Click Yes, I want to restart my computer now and then click Finish. Remove 
the CD from the drive. The system will restart. 

 

 Note 
Restarting is necessary because the Autoloader option is also being installed 
and the system must restart to determine the hardware configuration. The 
server containing the shared database must be running before other Backup 
Exec servers can be installed properly. 

 
27. Stop all Backup Exec services. 

28. Extract the Backup Exec patch files from the cpq-dt3315.exe file. 

This file contains two patches for two issues that can be applied to Backup 
Exec for Windows NT v8.0 (build 3315). 

This patch contains the following files: 

• devtypes.dll: Contains recognition for Compaq Fibre Channel driver 
CPQKGPSA.SYS 

• bserver.exe: Fixes a problem where utility jobs may hang on large Fibre 
Channel configurations 

 

! Important 
This patch should only be applied to Backup Exec for Windows NT/2000 v8.0 
(build 3315) 

 
29. Copy the files devtypes.dll and beserver.exe from the \<language> directory 

(created when the files were extracted) to the Backup Exec\NT program files 
directory. For example, for the English version of Backup Exec these files are 
located in the \Eng directory. 

30. Respond Yes when prompted to overwrite the existing files. 

31. Restart the server and log in. 

 Note 
As an alternate to installing Backup Exec on a second Windows NT server, 
you may choose to install Backup Exec on a Novell NetWare server and share 
the tape library. The NetWare installation lab can be found in the appendix. 
You can only share the library in a Fibre Channel Arbitrated Loop 
environment. 

 
 

! Important 
Complete the configuration lab before installing Backup Exec on the second 
server. 

 
This completes the lab exercise. 
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Configuring Backup Exec for the SAN 
Appendix B: Module 6 — Lab 2 

Objective 
After completing this module, you will be able to configure Backup Exec for EBS. 

Requirements 
The requirements for this lab are the equipment used in the previous labs with the 
previous labs completed. 
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Procedure 

Run Configuration Wizards 
1. Start Backup Exec by clicking Start → Programs → VERITAS Backup Exec 

→ VERITAS Backup Exec. The First Time Startup Wizard displays. 

  
2. Click Next. The Media Overwrite Introduction window displays. 
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3. Click Select Overwrite Protection Level. The Overwrite Protection Level 
window displays. 

  

4. Make sure Partial and Prompt before overwriting imported media are 
selected, then click Next. The Preferred Overwrite Media Type window 
displays. 
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5. Make sure the Overwrite scratch media option is selected and click Next. The 
Virus Protection window displays. 

  

6. Click Finish. The Device Configuration Wizard window displays. 
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7. Click Next. The Detected Hardware window displays. 

  

8. Click Next. The Drive Configuration window displays. 
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9. Click Next. The Device Configuration Complete window displays. 

  

10. Click Finish. The Backup Exec Assistant displays. 

  

11. Deselect Always show me this at startup and click Close. 
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Partition the Library 
 

 Note 
Only perform this part of the lab if you will be sharing the library between 
Windows NT/2000 and NetWare. When sharing the library, you specify the 
slots that each operating system will use since the tape are formatted 
differently for each operating system. 

 
1. From the Devices tab, right-click the changer for the loader containing the 

slots that you want to partition and select Configure Partitions. 

 
 

2. Select the loader slots to include in each partition by clicking the slots on 
which each new partition should begin. A partition divider listing the range of 
slots included in the partition is inserted wherever you click. 

 

 Note 
Partitions can include any number of loader slots; however, the first partition 
cannot be moved or deleted until no other partition definitions exist. 

 
3. Click OK after completing the configuration of your partitions. You will be 

prompted to confirm your selection. 

The partition drive pools appear under the Changer listing for the loader on 
which they were created. All partition drive pools for a changer have the 
same name and display the slot ranges for the partition in parentheses within 
the name. 
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Procedure for NetWare 

1. From the Job Manager screen, press <Ctrl + O> to access the Options menu. 

2. Select Options → Partition Management. The Partition Management window 
displays. 

 
 

3. Select Define/Maintain Partition and press Enter. The Define/Maintain 
Partition window displays. 

 
 

4. Press Del to delete existing partitions that you want to redefine. You may 
also want to edit existing loader partitions to update the number of slots to be 
used. 

5. To create a new partition, press Ins. A screen listing the available loader(s) 
will appear. 
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6. Move the selection arrows next to a drive that you want to include in the 
partition and press F2. The Partition Description window displays. 
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Inventory the First Partition 
1. Exit the command prompt and return to Backup Exec. 

2. Click the Devices tab. 

3. Right-click Changers and select Refresh. 

 
 

4. Right-click the first partition and click Inventory. 
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Erase the Tapes in the Partition 
1. Right-click one of the tapes in the first partition and select Erase → Quick. 

  
A warning message displays. 

 
 

2. Read the warning message and click OK. A confirmation message displays. 

  
3. Read the message and click Yes. 

4. Wait for the tape to be erased. 

5. Repeat steps 1 through 5 for the other tapes in the partition. 

This completes the exercise. 
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Running a Simple Backup Job 
with Backup Exec 

Appendix C: Module 6 — Lab 3 

Objective 
After completing this module, you will be able to run a simple backup using 
Backup Exec software. 

Requirements 
The requirements for this lab are the equipment used in the previous labs with the 
previous labs completed. 
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Procedure 

Using Backup Exec on Windows NT 
1. Start Backup Exec by clicking Start → Programs → Veritas → Backup Exec 

→ VERITAS Backup Exec. 

 
 

2. The VERITAS splash screen will display, followed by the Backup Exec 
Assistant screen. 
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3. Click the Backup Selections tab at the bottom of the screen. Select a few files 
and/or directories by checking the boxes next to the data to be backed up. 

 
 

4. Click the Backup button from the toolbar. The Backup dialog box displays. 
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5. Provide the information on the General tab, which must be provided for every 
backup: 

! Job Name — Enter a name (up to 25 characters) that describes the device or 
data that you are backing up. This name is used to differentiate backups in 
Backup Exec. 

! When this job begins 

• Overwrite media — Select this option to place this backup on 
overwritable media. Ensure that appropriate media is in the stand-alone 
drive or drive pool you select in the Device field. The media in the drive 
is overwritten if the media is scratch (unwritten) or recyclable (its 
overwrite protection period has expired). If allocated or imported media 
is in the drive, it also might be overwritten, depending on the Media 
Overwrite Protection Level. If the media in the drive is not overwritable, 
a message is displayed requesting that you insert scratch media. 

• Append to media, overwrite if no appendable media is available — 
Select this option to append this backup to the media set listed in the 
Destination/Media Set fields. The backup set is appended if appendable 
media is available in the selected media set. If not, overwritable media 
is used and added to the media set. 

• Append to media, terminate job if no appendable media is available 
— Select this option to append this backup to the media set listed in the 
Destination/Media Set fields. The backup set is appended if appendable 
media is available in the selected media set; if not, the job is terminated. 

! Media Name — Specify a label for the new or overwritable media. 

! Backup Set Description — Enter a description of the contents you are 
backing up. 

! Backup Method for Files — Select a backup method. 

! Destination 

• Device — Select a drive pool or stand-alone drive to be used for 
processing the backup. Ensure that appropriate media (overwritable or 
appendable) is in the stand-alone drive or drive pool you select. If the 
media in the drive is not overwritable or appendable, a message is 
displayed requesting that you insert scratch media. 

• Media Set — Select the media set for the backup. If you selected 
Append to media, this backup is added to other backups on media 
belonging to this media set. 

 

! Important 
For this exercise, select the first partition created in the earlier lab in the 
Device field. 
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6. After entering the information for your backup, click Run Now. 

7. To monitor the operation while it is processing, click the Job Monitoring tab 
at the bottom. (It should be blue in color.) Then double-click the job you 
want to view. The Active Job screen will display. 
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8. It is likely that Backup Exec will display a media information screen with a 
description of the media you will be overwriting. Close this screen. 
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Using Backup Exec on NetWare 
1. Copy a few files and directories from the Windows NT server to the SYS 

volume of your NetWare server. 

2. From the NetWare server, switch to the Backup Exec – NetWare Client 
screen. 

3. Select Commands → Backup → Make Selections. 

4. Select NetWare File System and press Enter twice. 

5. Log in as your admin user. 

6. Select the SYS volume and press Enter. 

7. Select a few files and directories by highlighting them and pressing the 
spacebar. 

8. Press <F2> to accept the selections. 

9. Select Submit and press Enter. 

10. Enter a job name and select Quick check. 

11. Select Target Partition and press Enter. 

12. Select Partition 1 (the second partition made for the library) and press Enter. 

13. Press <F2> to accept your selections. 

14. Enter a backup set name and press Enter. 

15. Press any key to continue. 

16. Wait for the job to finish, then delete one or more of the directories and files 
you backed up. 

17. Return to the Backup Exec – NetWare Client screen on the NetWare server. 

18. Select Commands → Restore → Make Selections by Device. 

19. Press Enter until your backup set displays. 

20. Select your backup set and press Enter. 

21. Select some of the files you deleted and press the spacebar. 

22. Press <F2> to accept the selections. 

23. Select Submit and press Enter. 

24. Press <F2> to accept the default locations. 

25. Enter a job name and press <F2>. 

26. Press any key to continue. 

This completes this lab. 
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Rev. 3.12 D – 1 

Installing CA ARCserve 2000 
for Windows NT 

Appendix D: Module 6 — Lab 1 

Objective 
After completing this module, you will be able to install and configure ARCserve 
2000 and the Enterprise Library Option for Microsoft Windows NT. 

Requirements 
! Windows NT 4.0 with Service Pack 6. 

! For the shared database server, 300MB of free hard disk space and 128MB 
RAM are recommended. 

! For other servers on the loop, 25MB of free hard disk space is required and 
64MB RAM is recommended. 

Before You Install 
For a Fibre Channel connected installation, additional requirements include: 

! A Fibre Channel host bus adapter (HBA) and its device drivers must be 
installed. 

! For ARCserve 2000 to automatically configure the library hardware and 
properly associate the tape drives with the library, the Fibre Channel HBA 
must be connected to recognize all the secondary storage devices. For the 
adapter to do this, the following requirements must be met: 

• The storage hub must be connected to all the Fibre-to-SCSI bridges on 
the loop. 

• All the tape libraries must be connected to the bridges. 

• The storage hub and all tape libraries must be powered up before 
powering up the bridges. 

• The bridges must be powered up before Windows NT 4.0 loads the 
Fibre Channel driver (usually during the restart phase). 
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Procedure 
1. Insert the CD into the CD-ROM drive and wait for the autorun option to 

display the Product Explorer. 

 
 

2. Expand ARCserve 2000 Advanced Edition and double-click Standard Setup. 
The Welcome screen displays. 
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3. Click Next. The Software License Agreement window displays. 

 
 

4. Select I accept the terms in the license agreement and click I Agree. The 
Customer Information window displays. 
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5. Leave the default values and click Next. The Setup Type window displays. 

 
 

6. Make sure Complete is selected and click Next. The Change Current 
Destination window displays. 
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7. Keep the default directory and click Next. The Select Database window 
displays. 

 
 

8. Make sure ARCserve Standard Database is selected and click Next. The 
Ready to Install window displays. 
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9. Click Install. A File in Use window may display. If it does, close the 
applications listed and click Retry. When the files are finished being copied 
the System Account window displays. 

 
 

10. Enter the information for your Administrator account and click Next. The 
Setup Completed window displays. 
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11. Click Finish. 

12. Click Yes to restrt the server and log in. A licensing message displays. 

 
 
 

▲▲▲▲ 
Note 
A serial number is not required for ARCserveIT’s fully functional evaluation 
version. 

 

13. Select Do not show this dialog again. 

14. Insert the ARCserve 2000 CD and wait for the Product Explorer window to 
display. 
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15. Expand ARCserve 2000 Tape Library Option and double-click Standard 
Setup. The Welcome window displays. 

16. Click Next. The License window displays. 

17. Select I accept the terms in the license agreement and click I Agree. The 
Customer Information window displays. 

18. Click Next. The Ready to Install window displays. 

19. Click Install. 

20. Wait for the Setup Complete window to display and click Finish. The Assign 
Devices window displays. 

 
 

21. Click Next. The Assign Cleaning Tape window displays. 
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22. Select the library and click Properties. The Properties window displays. 

 
 

23. Select Tape cleaning slot installed and enter the number where the cleaning 
tape is located.  

24. Select Bar code reader installed and click OK. 

25. Click Next. The Advanced Settings window displays. 
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26. Do not select any options. Click Next. The Summary window displays. 

 
 

27. Click Finish. The Device Configuration Complete window displays. 
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28. Click Exit. The Product Explorer window displays. 

 
 

29. Expand Storage Area Network Option and double-click Standard Setup. The 
Welcome screen displays. 

30. Click Next. The License agreement window displays. 

31. Select I accept the terms in the license agreement and click I Agree. The 
Customer Information window displays. 

32. Click Next. The Ready to Install window displays. 

33. Click Install and wait for the installation to complete. 

34. Click Finish. The SAN Option Configuration window displays. 
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35. If this is the first server on your SAN, select the server in the Available 
ARCserveIT Servers field and click Make Primary. Do not close this 
window. If this is the second ARCserve server, click the second server’s 
name in the Available ARCserveIT Servers field and click Assign 
Distributed. (You can change the “primary” and “secondary” status of all 
servers from any of the participating servers console if proper communication 
exist between the servers.) 

36. Log in. If you are installing the second server, return to the second server’s 
console to continue if you are not currently at the second server’s console. 

37. Return to the Product Explorer and exit. 

38. Exit Setup Launcher. 

39. Repeat the exercise for the second server. 

40. When both servers have been installed, restart the servers and log in. Make 
sure the Primary server (first server installed) fully loads and you are logged 
in before starting the second server. 
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Running a Simple Backup Job 
with ARCserve 2000 

Appendix E: Module 6 — Lab 2 

Objective 
After completing this module, you will be able to run a simple backup using 
ARCserve 2000 software. 

Requirements 
The requirements for this lab are the equipment used in the previous labs with the 
previous labs completed. 
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Procedure 
1. From the ARCserve Manager, click Backup Wizard. The Backup Wizard 

window displays. 

 
 

2. Click Next. The What server do you want to back up? window displays. 

3. Select your server and click Next. The What do you want to back up? window 
displays. 
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4. Select a few files and/or directories and click Next. The Where do you want 
to back up? window displays. 

 
 

5. Click Next. The Which Backup Options would you like to use? window 
displays. 
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6. Keep the default values and click Next. The When do you want to run this 
backup? window displays. 

 
 

7. Make sure Run Now is selected and click Next. The Backup Wizard is almost 
Complete window displays. 
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8. Enter a name for the backup and click Finish. The Job Monitor window 
displays. 

 
 

9. When the Operation successful window displays, click OK and close the Job 
Monitor. 

10. Immediately repeat steps 1 through 9 for the second server. 
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Performing a Serverless Backup with Performing a Serverless Backup with Performing a Serverless Backup with Performing a Serverless Backup with 
ARCserve 2000 Advanced EditionARCserve 2000 Advanced EditionARCserve 2000 Advanced EditionARCserve 2000 Advanced Edition    

Appendix F: Module 6 — Lab 3    

 

Objective 
 

After completing this module, you should be able to perform a Serverless backup 
using BrightStor ARCserve 2000 Advanced Edition with the Serverless Option. 

 

 

Requirements 

 
• Backup/Database Server with: 

o Windows 2000 with Service Pack 2 minimum (for large LUN support). 

o 128MB RAM 

o BrightStor ARCserve 2000 Advanced Edition installed 

o Tape Library, Storage Area Network, Image and Serverless Backup 
Options installed 

• HSG80 Storage Subsystem with: 

o Clone of mirrorset presented to Backup/Database Server created with 
SANworks Enterprise Volume Manager 

• HP StorageWorks M2402 Network Storage Router 

• Latest patches from http://www.cai.com for ARCserve 2000 

 

 

Procedure 
 

! Important 
Be sure to have applied the latest patches from http://www.cai.com for 
ARCserve 2000. 

 
To perform a Serverless backup, it is necessary to first enable Serverless support.  This can be done 
through the Image/Serverless Wizard or directly in ARCserve Manager. 
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Note: You can only perform a serverless backup on a machine where both ARCserve 

and the Serverless Backup option are installed. 

 

1. In the Visual Manager Interface of the Network Storage Router, be sure that 
under System > Active Fabric, the setting for Server Free Backup Mode is set 
to Enabled. 

2. Launch ARCserve Manager. 

3. Click the Backup link. The Backup Manager dialog appears: 

 

 

4. Click the Image/Serverless Wizard button on the ARCserve toolbar. The 
Image/Serverless Wizard dialog appears: 
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5. Click the Enable the following selected drives only radio button and select the 
clone you created with EVM.  Click Next. The Image/Serverless Backup 
Wizard – Options dialog appears: 

 

 

 

 

 

6. Leave the default selections as is and click Finish.  The Backup Manager 
dialog is displayed again: 
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7. In the Source window, select only the cloned drive by clicking the radio 
button next to the disk. 

8. Click the Destination tab and select the media group to backup to. 

 

 

 

 

9. Click the Schedule tab and select the Run Now radio button to scheule the job 
to start immediately. 

 

 

 

10. Click the Traffic Light Icon in the Backup Manager window to start the 
backup. 

11. In the Job Properties dialog, it will indicate that the Serverless Backup option 
has been used by displaying “Serverless Backup” in the Drive field. 
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# This completes the serverless backup lab. 



Designing and Implementing HP Enterprise Backup Solutions 

F – 6 Rev. 3.12 
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Installing Legato NetWorker 6.0.1 
for Windows NT 

Appendix G: Module 6 — Lab 1 

Objective 
After completing this module, you will be able to install and configure NetWorker 
for Microsoft Windows NT. 
 

Requirements 
! Windows NT 4.0 with Service Pack 6 

! 64MB RAM 

! 44MB free disk space for NetWorker software 

! Enough free disk space to allow for 5% of total backup data (allow for up to 
3 times the index size during software update conversion) 

Before You Install 
NetWorker for Windows NT supports the Microsoft Autorun technology. Autorun 
automates part of the NetWorker installation process. Because of differences in 
web browser capabilities, Autorun can either bring up a Welcome screen (if you 
are using Microsoft Internet Explorer 3.0x or later) or start the installation program 
(if you are using Netscape). The type of installation is determined by which 
browsers are installed and which one is the default. 

If the Autorun feature on your computer has been disabled, you can start the 
installation through Windows Explorer. Right-click the CD-ROM drive icon and 
select “Install NetWorker” from the pop-up menu. 

You can also start the installation program manually from your NetWorker CD-
ROM if, for example, Internet Explorer has been disabled on your computer. 

In this lab, we will use the Autorun feature to install NetWorker. 
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Procedure 

Installing the Client and Server 
1. Edit the hosts file from the C:\winnt\system32\drivers\etc subdirectory and 

enter the ip addresses and hostnames of your two servers. (In the pictures, the 
two hostnames are pdc.domain and bdc.domain) 

 

2. Make sure that under Control Panel > Tape, the tape device drivers are 
loaded.  If not, then load the native NT tape driver for your tape library by 
clicking on Detect under the Devices tab and then Add under the Drivers tab. 

3. Insert the NetWorker Servers, Clients, & Storage Nodes CD into the CD-
ROM drive and wait for the autorun option to display the menu.  

Use explorer to run the file off the server. 
E:\LEGATO\WIN32\NW57\WINNT\I386\AUTORUN\AUTORUN.HTML 
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4. Scroll to the bottom of the window and select NetWorker 5.5.2 for Windows 
NT (i386). The Confirm File Open window displays. 

 

 

 

5. Select run this program from its current location, then click OK 

 

 

 

6. When the security-warning screen appears, click YES. 
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7. When the Confirm File Open appears, Click Open. The Setup Options 
window displays. 

 
 

8. Select Server and Client and click Next. The Choose destination directory 
window displays. 
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9. Keep the default installation directory and click Next. The Authorize 
NetWorker Servers window displays. 

 

 
 

10. The Authorized NetWorker Servers are all NetWorker servers this client can 
back up to. You are installing both the client and server pieces on the first 
server. However, the client can use another NetWorker server to back up data 
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located on this server. Enter your server’s name and click Next. The 
NetWorker client and server software are installed. 

 
 

11. Once the installation is complete, click OK. 
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Configuring the Server 
12. Run NetWorker Administrator from the NetWorker Program Group. A 

warning displays. 

 
 

13. Click OK.  The Welcome to NetWorker window displays. 

 
 

14. Click NetWorker Wizard. 

 



Designing and Implementing HP Enterprise Backup Solutions 

G – 8 Rev. 3.12 

 
 

15. The Who administers your system? window displays.  Type in the 
administrators of your second server as well and Click Next. 
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16. By default, the Administrator Account is added. If additional administrators 
need to be added, enter them in here and click on add. For this lab, Click 
Next. 

 

 Note 
*@* means anyone from anywhere can administer this server. Be very careful 
when using this designation. 

 
 

 
 

17. The Saving your files manually window displays, make sure Yes is selected 
and click Next.  
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18. When the First step is complete window displays, click Next. 

 

 

 

 

 

  Note: The NetWorker server is now configured. 
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19. The Create new clients windows displays, your server should appear in the 
list of current clients. Select No and click Next.  

 

 

 

20. The Second step is complete window displays, click Cancel.  
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21. A warning screen appears, click Yes. 

 

 
 

22. The NetWorker Administrator window displays, from the NetWorker 
Administrator window, click Devices: set up, mount, unmount, label. The 
Devices window displays. 
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23. Select \\Tape0 and press the Delete key. 

  Note: By default, NetWorker creates a default 4mm device. This is why we  
are deleting it. 

 
 

24. A warning displays, click Yes. 

25. Wait for the device to be deleted and then close the Devices window. 

26. Open a MS Dos Command prompt. 
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27. Change to the Win32app\nsr\bin directory. 

   Note: If using FCTCs then complete step 17, otherwise skip to step 18. 

28. Enter inquire –l and press Enter. This command searches all SCSI 
devices and lists them. The –l option allows the search to skip any breaks in 
LUNs. 

29. Write the names for your drives in the spaces provided (for example, 
\\.\Tape0)  If you do not see any Tape devices listed, check Control Panel > 
Tape to see if the drivers are loaded. 

............................................................................................................................  

............................................................................................................................  

30. Enter jbconfig –l and press Enter. 

 

 
31. Enter 2 and press Enter. 
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32. Wait for the library to be found. This may take several minutes.  Enter the 
appropriate number for your library and press Enter. 

33. Enter a name for your library and press Enter.  

  Example: TL800, TL895 

34. Press Enter to accept the auto-detected pathname for the control port for the 
library. 

35. Enter yes and press Enter when asked if you want auto-cleaning support 
enabled. 

36. Press Enter to accept this server as the owner of drive 1. 

37. Enter the name for drive 1 that you recorded in Step 18 and press Enter. 

Example: \\.\tape0 

38. Enter 15 (the dlt7000 tape device) or 20 (the tz89) and press Enter. 

39. When asked to enter the hostname that owns media drive, type the hostname 
of your second server (bdc.domain).  

40. Enter the name for drive 2 that you recorded in step 18 and press Enter. 

41. Enter yes to enable bar code reader support and press Enter. 

42. Enter yes to have volume labels match barcodes and press Enter. 
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43. Exit the command prompt and return to NetWorker Administrator. 

Note: If not running two servers, skip to step 35.  

44. Install the NetWorker client on the second server.  At the SETUP Options 
screen, select Client Only. 
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At the Authorize NetWorker Servers screen, type in the host name of the first 
server. 
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45. After the second server is installed, return to NetWorker Administrator on the 
first server. 
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46. Click Autochanger: set up, mount, unmount, label to view the library and 
drives. 

 

 
 

47. Right-click the TL891 library. 

48. Click Operations. The Autochanger Operations window displays. 

 
 

49. Click Label. 
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50. Change the slot range to include only one tape. 

51. Select Slow/Verbose. 

52. Click OK. 

53. Wait for the tape you selected to be formatted and labeled. 

54. Close the Autochanger Operations window. 
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55. Click Options → Customized. 

 

56. Select Go Direct to Expanded Server Resources and Display Hidden 
Attributes.  Leave Display Schedules as Calendars selected. 
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57. Click Polling Intervals. 

58. Change the secondary polling interval to 32767. This changes the polling 
interval to avoid a known problem. If left at 60 seconds, the devices 
disappear after 60 seconds and do not show up until the screen is refreshed. 

59. Click OK. 

 

60. Close the right-hand window that is within the NetWorker Administrator 
window. You will get a warning message; click YES.  
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61. Reopen it using the new settings by clicking NetWorker Servers in the left-
hand pane and then double clicking on your network server. 

  Note: If you only have one server, then this completes the lab, otherwise 
continue on. 
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62. Right-click Clients and choose Create. The Create Client window displays. 
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63. Enter the name of the second server (where only the client is installed) in the 
Name field. 
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64. Click Preferences. 

65. Enter the name of the second server in the Storage nodes field. 
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66. Click Remote. 

 

67. Enter Administrator@<servername> (replacing <servername> with the name 
of the second server) in the Remote access field. 

68. Click OK. 



Designing and Implementing HP Enterprise Backup Solutions 

G – 28 Rev. 3.12 
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Running a Simple Backup Job 
with NetWorker 

Appendix H: Optional Module 3 — Lab 6 

Objective 
After completing this module, you will be able to run a simple backup using 
NetWorker software. 

Requirements 
The requirements for this lab are the equipment used in the previous labs with the 
previous labs completed. 
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Procedure 
1. Open NetWorker Administrator program.  Double-click the NetWorker 

server in the left frame. 

 

2. Expand the Groups icon. 
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3. Right-click the Default group and select Edit. 

 

 



Designing and Implementing HP Enterprise Backup Solutions 

H – 4 Rev. 3.12 

4. Verify that the appropriate administrators are listed in the Administrator field 
near the bottom of the window.  Click OK. 

 

5. To start a backup of both servers in the Default group, right-click the Default 
group and choose Start.   

 

 Note 
If you wish to back up only one server, you would create a group.  Then 
modify the properties of the associated clients to associate them to the new 
group.  If you wish to back up only certain directories as opposed to the entire 
server, you would also modify the properties of the associated client. 

 

 

 

6. Click Yes to start the backup. 
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7. To monitor the backup, click on the Monitor tab.   
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8. You can see other messages about the status of the backup by going back to 
the Configure tab, then right-clicking the group being backed up, and 
selecting Details. 
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Installing VERITAS Backup Exec 8.5 
for NetWare 5 

Appendix I: Module 6 — Lab 1 

Objective 
After completing this module, you will be able to install and configure Backup 
Exec and the Shared Storage Option for Novell NetWare. 
 

 Note 
Sharing the library with a Windows NT server can only be accomplished in a 
Fibre Channel Arbitrated Loop environment. 

 
 

Requirements 
! NetWare 5.0 with Support Pack 4, Netware 5.1, or Netware 4.11 with 

Support Pack IWSP7A. 

! 128MB RAM is recommended. 

Before You Install 
For a Fibre Channel connected installation, requirements include: 

! A Fibre Channel host bus adapter (HBA) and its device drivers must be 
installed. 

! For Backup Exec to automatically configure the library hardware and 
properly associate the tape drives with the library, the Fibre Channel HBA 
must be connected to recognize all the secondary storage devices. For the 
adapter to do this, the following requirements must be met: 

• The storage hub must be connected to all the Fibre-to-SCSI bridges on 
the loop. 

• All the tape libraries must be connected to the bridges. 

• The storage hub and all tape libraries must be powered up before 
powering up the bridges. 

• The bridges must be powered up before Windows NT 4.0 loads the 
Fibre Channel driver (usually during the restart phase). 
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Procedure 
1. Mount the VERITAS CD as a volume on the NetWare server. 

2. Enter the following command from the server console: 

load veritas:\netware\beinstl.nlm 

3. Select the appropriate language and press <F2>. 

4. Enter the product serial number. For training purposes, leave these fields 
blank and press <F2>. 

5. Select Multiserver Edition with Advanced Autoloader Option, press the 
spacebar, and then press <F2>. 

6. Read the license agreement and press <Esc> then <F2> to accept the license. 

7. When asked if you want to evaluate the Open File Option, press n. 

8. Select Custom installation and press the spacebar and then press <F2>. 

9. Update the Novell NLMs by pressing y. 

10. Press Enter to display a list of controllers. 

11. Select Compaq FC Host and press Enter. 

12. Press <F2> to accept the selected controller. 

13. Enter your admin name and password and press <F2>. Depending on your 
NDS configuration (whether or not the target server hosts a read/write 
partition replica) you may be required to input the admin account name in the 
fully qualified format (for example, .cn=admin.o=container_name) 

14. Press y to have the Backup Exec NetWare Client load automatically when 
Backup Exec is loaded. 

15. Press y to have Backup Exec load automatically on server startup. 

16. If you encounter name space warnings, read the warning and press any key to 
continue. 

17. Wait for files to install, the press any key to continue. 

18. Press n when asked to update other NetWare servers. 

19. Press y to create the smdrincl.dat file. Make sure to only include this server in 
the smdrincl.dat file. Including additional servers will cause startup delays 
while the NetWare client scans for Backup Exec agents running on those 
other servers. 
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20. Press <F2> to select your server. 

21. Read the message regarding autoexec.ncf and press any key. 

22. Press <F2> to exit the installer. 

23. Enter the following command at the server console: 

bestart 

24. Log in to your server as your admin object. 

25. Switch to the Backup Exec – Job Monitor screen. 

26. Read the message about shared devices and press y. 

27. Select Enable support for shared devices and press the spacebar. 

28. Select Designate this server as the Primary Group Server and press the 
spacebar. 

29. Press <F2> to accept your selections. 

30. Read the message regarding the Primary Group Server and press any key. 

31. Read the message regarding overwrite protection and press y. 

32. Select Protect media from being overwritten and press the spacebar. 

33. Change the retention period to five days and select Convert overwrite jobs to 
append jobs if necessary and press <F2>. 

This completes this lab. 
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VERITAS NetBackup Datacenter 3.4 Installation and 
Configuration 

Appendix J: Optional Module 4 – Lab 5 

Objective 
After completing this module, you will be able to install and configure NetWorker 
for Microsoft Windows NT. 
 

Requirements 
! Windows NT 4.0 with Service Pack 5 

! 32MB RAM 

! 100MB disk space 

 

Procedure 
1. Verify that the native driver for the tape drive has been installed. 

2. Insert the NetBackup Datacenter 3.4 CD and let the cd autorun. 
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3. Select NetBackup Server for Microsoft Windows NT. 

 

 

4. Click OK to continue. 
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5. Click Next to continue. 

 

 

6. When prompted for a license key, type in the key from the instructor. 
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7. Click on Next. 

 

 

8. On the first server, click NetBackup Master Server.  On the second server, 
click on NetBackup Media Server. 
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9. Uncheck the box for “Start NetBackup” and click Next. 

 

 

10. Enter the name of the Master Server and click on Next. 
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11. Click on Install to continue. 
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12. Uncheck the box for “Launch NetBackup Administration now”. 

 

 

13. Double-click on the patch for NetBackup 3.4. 

 



Designing and Implementing HP Enterprise Backup Solutions 

J – 8 Rev. 3.12 

 

14. Select Install patch to this computer only and click on Next. 

 

 

15. Click on Next. 
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16. Click on Next. 

 

 

17. Click on Finish to complete Setup.   

18. Install NetBackup Datacenter on the second server as a NetBackup Media 
server.  Then apply the patch to the second server. 
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19. From the NetBackup Master server, launch the NetBackup Administrator by 
selecting Start > Programs > NetBackup Administrator. 

 

 

20. To begin the Device Configuration wizard, click on Next. 
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21. Click on Next. 
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22. Click on Add and type in the name of the other server. 

23. Click on Next. 

 

 

24. Click on Next after auto-detection has completed. 
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25. Click on Next after verifying that the robot and drives in the tape library are 
recognized. 

 

26. Expand the robot by clickin on the + sign and verify that the drives in the 
tape library are listed as “Multihosted”.  Click on Next. 



Designing and Implementing HP Enterprise Backup Solutions 

J – 14 Rev. 3.12 

 

27. Click on Nex after updates are complete. 

 

 

28. Check the Storage Units and click on Next. 
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29. Click on Finish to complete the Device Configuration wizard. 

 

 

30. Expand the + sign next to the master server and click on the robot.  Then 
click on Next. 
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31. Click No so that only DLT tapes are used. 

 

 

32. Click next to start the robot inventory. 
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33. Verify that the results of the robot inventory.  All tapes in the library should 
be listed.  Click Next. 

 

34. If any of the tapes are cleaning tapes, check the corresponding box.  Click 
Next. 
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35. Click Finish to complete the Volume Configuration wizard. 

 

 

36. Launch the NetBackup Administration from Start > Programs > NetBackup 
Administration. 
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37. From the menu at the top, select Start > Configure NetBackup. 
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38. Click on Media Servers.  Then right-click and select Properties. 
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39. Select the Media tab.  Select allow media overwrite for all the choices.  Then 
click OK. 

 

 

40. Return to the NetBackup Administration window.  Select Media and Device 
Management. 
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41. Expand the + signs and verify that the robot, drives, and tapes are recognized.  
Then exit the window. 

 

42. Launch the NetBackup Administrator window.  Click on Backup Policy 
Management. 
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43. From the top menu, choose Class > New Class. 

 

  

44. Type in the name for the class and click OK. 
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45. Click on the Clients tab.  Then click on the small computer icon under the 
Operating System.  Add both the master and the media servers into the clients 
list. 
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46. Click on the Files tab.  Then click on the folders icon near the upper right 
corner.  Choose some folders on both servers to back up. 
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47. Click on the Schedules tab and then click New. 

 

 

48. Type a name for the schedule and select all times.  Change the retention to 1 
week.  Click OK. 
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49. From the top menu of the Backup Policy Management window, select Class 
> Manual Backup.   

 



Designing and Implementing HP Enterprise Backup Solutions 

J – 28 Rev. 3.12 

 

50. Return to the NetBackup Administration window.  Click on Activity 
Monitor. 

51. Right-click a particular backup job to monitor the progress of the backup. 
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Tivoli Storage Manager 4.1.1 Installation 
Appendix K: Module 6 – Lab 1 

Objective 
After completing this module, you will be able to install and configure NetWorker 
for Microsoft Windows NT. 
 

Requirements 
! Windows NT 4.0 with Service Pack 6 

! 64MB RAM 

! 110 MB disk space 

Procedure 
 

 
1. Insert the TSM 4.1 for Windows CD and install defaults as prompted.  

Reboot. 

2. Install the TSM 4.1.1. upgrade.  Reboot. 
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3. Access TSM Server Utilities via icon.  When windows appear, choice for 
Initial Configuration should be default.  Click OK to configure. 

 

4. Default is to have additional info displayed during procedures.  Click Next. 
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5. Default is Network configuration.  Click Next. 

6. Click Finish to complete Initial Configuration Wizard. 

 

7. Click Next to start Performance Wizard. 
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8. Default is 2-49 clients, and a mix of small and large files.  This will suffice 
for our test purposes.  Click Next. 
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9. Performance Wizard will now analyze the available volumes for 
recommendations on where to set up disk storage pools, recovery logs, etc. 
Click Next when complete.  Click Finish to complete. 
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10. Click Next to start Server Initialization Wizard. Click Next. 

 

11. Leave defaults for Server Key and Location Information.  Click Next. 
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12. Leave defaults for volume locations.  Click Next. 

 

13. Leave the System account as the choice for login account.  Choose 
Automatically when Windows boots for the service start choice.  Click Next. 

14. Click Finish to complete Server Initialization. 
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15. Click Next to start the Disk Storage Pool Volume wizard. 

 

16. For our purposes, the disk storage pool volume needs to be relatively small.  
We are more interested in writing to tape than providing quick access to 
incremental data for restore purposes.  Make DISKPOOL 100 MB.  Click 
Next. 
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17. Leave defaults for storage pool size. Click Next. 
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18. Choose defaults for database volume wizard. 
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19. In recovery volume wizard, make sure volume is at least 100 MB.  Entering 
23 in the calculation window will create a recovery log volume of 101 MB.  
Click Next, then Finish. 
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20. In license wizard, enable 50 Managed System for LAN licenses, 50 Managed 
System for SAN licenses, one Shared Library license, and several Managed 
Library licenses if this is the library master.  If it is a library client, do not 
enable the Managed Library license. 
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21. In the service configuration wizard, click on Options. The Server service 
should already be started and set to Automatic.  Confirm and click Next. 
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22. Click on Options and configure the Device Driver to start automatically.  
Click Start to start the driver and click Next to continue.  NOTE:  Do not do 
this if you are using the IBM 3584 LTO tape library (Anaconda).  It uses its 
own drivers and not the TSM driver.   

 

23. The Scheduler service will need to be installed later via the Backup/Archive 
GUI.  Click Next to continue. 

24. DO NOT USE THE DEVICE CONFIGURATION WIZARD.  
Configuring the library and drives are more easily done via command line.  
Click Cancel to opt out of this wizard.  Click Yes when asked if you want to 
mark this wizard as completed. 
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25. DO NOT USE THE CLIENT NODE CONFIGURATION WIZARD.  
You will need to set up the local client node after configuring the library.  
Again, when prompted, mark the task as completed. 

26. DO NOT USE THE SCHEDULING WIZARD.  This is best done after 
configuring the client node.  Mark the task as completed. 

27. DO NOT USE THE CLIENT OPTIONS WIZARD.  This is only for 
setting up specific situations for backup clients.  As we will work only with 
servers, this is unnecessary.  Mark the task as completed. 

28. This completes the initial server setup.  Click no when prompted to begin a 
backup of the local client. 
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Rev. 3.12 L – 1 

Tivoli Storage Manager 4.1.1 Configuration and 
Backup 

Appendix L: Module 6 – Lab 1 

Objective 
After completing this module, you will be able to configure Tivoli Storage 
Manager with Microsoft Windows NT and then run a backup job. 
 

Requirements 
! Windows NT 4.0 with Service Pack 6 

! 64MB RAM 

Procedure 
 

After installing TSM and running the wizards as outlined in the Installation 
Procedure, perform the following functions to configure TSM for the lab 
environment. 

 

NOTE:  The web-based interface is the easiest way to perform these tasks; therefore, all 
instructions in this procedure will refer to the web-based commands. 

1. Open the Tivoli Storage Manager Server Utilities by clicking on the desktop 
shortcut. 

 

2. Click on Server Options and then click on Edit. 
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3. Click on Yes to create the options file. 

 

4. In order for changes to take effect, stop and restart the TSM Server service in 
the Control Panel > Services. 

 

5. Open the browser and bring up the admin page of http://localhost:1580 .  Log 
in as admin, password admin. 
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6. Click on Object View. 
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7. Click on Clients. Then Click on Client Nodes. 

8. The default client will be the only Client Node listed.  This node must be 
deleted to enable the deletion of the default policy domain later.  Click on the 
default client. 
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9. From the pull-down menu, choose Delete client node. 

10. Next, return to Object View.  Click on Server, then Server Status. 

11. Choose the server.  From the pull-down menu, perform the following status 
changes: 

Server name (eliminate the “_SERVER1” on the end) 

IP address 

Port # (1500) 

URL (http://<server>:1580) 

Password (admin) 

Crossdefine (on) 

Password expiration (900) 

Web Administration Time Out (0) 

Activity Log Retention (7) 

 



Designing and Implementing HP Enterprise Backup Solutions 

L – 6 Rev. 3.12 

LIBRARY SETUP  
 

Library Manager procedure: NOTE: This is only performed on one TSM server, 
namely the Library Manager. 

 

1. Go to Object View, then Server Storage, then Libraries and Drives, then 
Automated Libraries. 

2. From the pull-down menu, choose Define Automated Library.   

3. Give the library a name.   

4. In the Device Name field, put the proper device information as defined in the Device 
Information window of the TSM Server Utilities console.  The library device name 
should look something like “lb0.1.1.3”. 

5. In the Element field, provide the number associated with the robot.  This number can 
be found at the TSM web site by looking under “Requirements and Supported 
Devices” for TSM.  Look up the particular library you are trying to configure.  The 
page will list all the element numbers for the robot and drives within the library.  
Make a note of these numbers—they will be needed for setting up the automated 
drives later. 

6. After defining the library, the drives must be set up.  Go back to Object View, then 
Server Storage, then Libraries and Drives, then Automated Drives. 

7. From the pull-down menu, choose Define Automated Drives. 

8. Give the drive a name. 

9. Choose the library previously defined. 

10. In the Device Name field, put the proper device information as defined in the Device 
Information window of the TSM Server Utilities console.  The drive device name 
should look something like “mt0.2.1.3”. 

11. In the Element field, provide the number associated with the drive IN THE PROPER 
ORDER within the library.  Make sure that the proper element number is associated 
with the proper device. 

12. Repeat the above drive procedure for each drive in the library. 

13. Go to Object view > Server Storage > Libraries and Drives > Library Volumes > 
Operations > Label Library Volume.   

14. Make the following changes: 

Search Library  Yes 

Source  Barcode 

Library Category  Scratch 

Overwrite Existing Label  Yes 
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Library Client procedure:  

Perform this for all TSM servers sharing the library with the TSM library manager.  Do 
not perform this for the TSM library manager.   

 

1. First, connectivity must be established with the library manager.  Go to Object 
View, then Server, and then Other Servers. 

2. From the pull-down menu, choose Define Server.  Fill in the proper information for 
the library manager, and set Crossdefine to yes.  When communication is 
established, proceed to library setup. 

3. To set up a shared library, go back to Object View, then Server Storage, then 
Libraries and Drives, then Shared Libraries. 

4. From the pull-down menu, choose Define Shared Library. 

5. Fill in the library name as defined on the library manager.  Fill in the name of the 
library manager in the Primary Library Manager field. 

6. To set up shared drives, go back to Object View, then Server Storage, then Libraries 
and Drives, then Shared Drives. 

7. From the pull-down menu, choose Define Shared Drive. 

8. Fill in the name of the drive as defined on the library manager. 

9. Choose the shared library previously defined. 

10. In the Device Name field, put the proper device information as defined in the Device 
Information window of the TSM Server Utilities console.  The drive device name 
should look something like “mt0.2.1.3”.  NOTE: The device name information may 
be different from that on the library manager—this information is defined as how the 
operating system sees the drives. 

11. Repeat this procedure for all drives in the shared library. 
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Policy Domain Setup 
This procedure is to be performed at each TSM server. 

1. Now set up the policy domain.  Go back to Object View, then Policy Domain. 

2. Choose the default domain and, using the pull-down menu, delete the 
domain. 

3. From the pull-down menu, choose Define Policy Domain. 

4. Give the domain a name that applies to the library that will be associated with it. 
Leave all other defaults. 

5. The new domain should be listed.  Choose it and then click on Policy Sets at the 
bottom of the page. 

6. From the pull-down menu, choose Define Policy Set. 

7. Give the policy set a name that corresponds with the domain.  Leave all other 
defaults. 

8. The new policy set should be listed.  Choose it and then click on Management 
Classes at the bottom of the page. 

9. From the pull-down menu, choose Define Management Class. 

10. Give the management class a name that corresponds with the policy domain and set.  
Leave all defaults. 

11. The new management class should be listed.  Choose it and then use the pull-down 
menu to choose Assign as Default Management Class.  Perform this function. 

12. Choose the management class just defined and click on Backup Copy Group at the 
bottom of the page.   

13. In the backup copy group fields, define the following: 

Copy Destination (DISKPOOL) 

Versions Exists (nolimit) 

Versions Deleted (nolimit) 

Retain Extra (nolimit) 

Retain Only (nolimit) 

Copy Mode (ABSOLUTE)    This will allow full backups.  

Do not define an archive copy group.  This is unnecessary for testing purposes. 

14. Go back to Policy Set.  Choose the previously defined set. 

15. From the pull-down menu, choose Validate Policy Set.  The screen will show a 
message warning that an archive destination has not been set.  This is because an 
archive copy group will not be defined.  A second message should say that the set is 
ready for activation. 

16. From the pull-down menu, choose Activate Policy Set.  The screen will again show 
the warning about not having an archive destination.  A second message should say 
that the set has been activated. 

17. Go back to Object View, then Server Storage, and then Device Classes. 
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18. From the pull-down menu, choose Define Device Class. 

19. Give the class an appropriate name.  Leave all other defaults, except make Mount 
Retention = 2 

20. Go back to Object View, then Server Storage, then Storage Pools, and then 
Sequential Access Storage Pools. 

21. From the pull-down menu, choose Define Sequential Access Storage Pool. 

22. Give the pool an appropriate name.  Leave all defaults, except make Maximum 
Scratch Volumes Allowed = 500. 

23. Go back to Storage Pools, then Disk Storage Pools.   

24. Delete ARCHIVEPOOL and BACKUPPOOL using the pull-down menu. 

25. Choose DISKPOOL. 

26. From the pull-down menu, choose Update Disk Storage Pool. 

27. In the Next Storage Pool window, choose the sequential access storage pool 
previously defined. 

28. Leave all other defaults, except make Low Migration Threshold = 10.  This will 
allow the migration procedure to almost completely move data from disk to tape 
before resuming a backup job. 

29. Finally, a client node must be defined for the server in the policy domain. 

30. Go to Object View, then Policy Domain.  Choose the policy domain. 

31. At the bottom of the page, choose Client Nodes. 

32. From the pull-down menu, choose Define Client Node.  

33. Define the following: 

Name (server name) 

Password (client) 

Policy Domain (domain previously created) 

Maximum Mount Points (1) 

Leave all other defaults. 

The TSM server is now configured.   
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Backup of TSM server 
 

 

1. To use the Backup/Archive GUI to run a backup, go to Start > Programs > 
Tivoli > Backup/Archive GUI 
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2. Pick a directory to backup.  Click on Backup. 
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Rev. 3.12 M – 1 

Installing and Configuring Legato NetWorker 6.0.1 
for Tru64 5.1 

Appendix M:  Module 6 – Lab 1 

Objective:  
To install and configure Legato NetWorker 6.0.1 for Tru64 5.1 and to backup and 
restore files. 

Requirements: 
! AlphaServer 

! KGPSA-BC or KGPSA-CA host bus adapter 
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Step 1 
Copying the Patch-Kit-3 Patch 

 

Note: The Tru64 UNIX operating system has patches that are released between major 
revisions. These patches either fix bugs or add enhancements. Tru64 5.1 patch kit 3 is 
a bundle of patches that are required and/or recommended as of today for Tru64 5.1. 
New patch kits are released as needed (usually quarterly). Patch kit 3 has a required 
enhancement for NetWorker 6.0.1. If running Legato in a cluster, use Patch Kit 2. 

 

1. Turn the Alpha server on. At the system prompt P000>> type b and hit Enter 

 

2. Log in as root with the password the appropriate password. 

 

3. Open a Terminal window and create a CDROM directory. 

 

   

 

4. Create a directory called home/os_patch/pk3 

 

 

 

5. Insert the Patch Kit 3 CD into the CDROM and mount it. 
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6. Copy the Patch Kit 3 file to /home/os_patch/pk3 directory. 

At the command prompt, #, type  

cp /cdrom/pk3/T64V51AS0003-20010413.tar home/os_patch/pk3 

 

 

 

7. Unmount the CDROM, remove the Patch Kit 3 CD from the CDROM drive.  

 

 

 

This completes the copying of the Patch Kit 3 file to the hard drive.
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Step 2 

Installing the Patch Kit 3 Patch 

 

8. Take the system into Single User Mode. 

At the system prompt, #, type init s and hit Enter.  

 

 

 

9. Display the hard drive space in kilobytes. 

At the system prompt, #, type df –k and hit Enter. 

 

10. Mount all volumes of the hard drive. 

At the system prompt, #, type mount –a and hit Enter. 

 

11. Go into the home/os_patch/pk3 directory.  

At the system prompt, #, type cd /home/os_patch/pk3 and hit Enter. 

 

12. Next run the T64V51AS0003-20010413.tar file.  

At the system prompt, # type tar xvf T64V51AS0003-20010413.tar 

 

13. Go into the patch kit subdirectory 

 

14. Run the Patch file. 

At the system prompt, # type ./dupatch 
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15. When asked for the path to the top of the patch distribution, type in 
/home/os_patch/pk3/patch_kit 

 

16.  The system will ask Which option you would like to install? Choose Option 1, Patch 
install. Type 1 and hit Enter. 

Note: Throughout the installation of the patch, the system will notify you on what is 
happening. It will then prompt you to hit Enter to continue. You may want to take the 
time to read the screen to get a better understanding on what is going on, if not, just hit 
Enter each time. 

 

17. The system will also prompt you again, for which option you would like to choose. 
For this lab, choose option 2, Check and Install. Type 2 and hit Enter. 

Note: In a real life environment, you would choose Option 1 first, once that completes 
and passes, then choose Option 2. 

 

18. The system will ask if you want to allow the volume to be reversible, state yes. Type 
yes and hit Enter. 

Note: Stating yes will allow you and or the customer to uninstall Patch Kit 3 Patch. 
This however, takes up a lot of disk space. Your customer may not want to do this. 

 

19. The system will request a name. Type in your name and hit Enter.  

 

20. The system will then ask for comment. You may want to type something in to the 
effect of I installed this patch kit to get the enhancements required for NetBackup 3.4 
and hit Enter. 

 

21. The system will list all the patches it has to offer. Scroll down to the bottom and select 
the number to install all patches. Type the number in and hit Enter. 

Note: If the system finds a patch that it cannot install, tell it to continue with out it.  

 

22. The system will ask Do you have a pre-existing configuration file? Type yes and hit 
Enter. 

 

23. The system will request for you to Enter the name of the pre-existing configuration 
file or hit return to you “your server name”. Mine was ALPHASEVEN. Hit Enter to 
continue. 
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24. The system will ask Do you want to edit the configuration file. Type n and hit Enter. 

 

25. The system will ask do you want to reboot now? Type y and hit Enter. 

 

26. Once the system reboots, it will take you back to the Log in prompt.  

 

This completes the installation of the Patch Kit 3 Patch portion of the lab. 
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Step 3 
NetWorker 6.0.1 Initial Installation Process 

 

27. Insert the NetWorker 6.0.1 CD into the CD-ROM and mount it.  

At the command prompt, #, type the command below and hit Enter. 

Note: If there is not a /cdrom directory already made, then you will need to make one. 

 

 

 

28. Go into the CDROM directory 

At the command prompt, #, type the command below and hit Enter. 

 

 

 

29. List the files to verify that there is a TRU64 directory 

At the command prompt, #, type the command below and hit Enter. 
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30. Go into the TRU64 directory. 

At the command prompt, #, type the command below and hit Enter. 

 

 

 

31. Install Legato NetWorker 6.0 

At the command prompt, #, type the below command and hit Enter. 

 

 

 

32. The below information appears, type 5 and hit Enter. 

 



Installing and Configuring Legato NetWorker 6.0.1 for Tru64 5.1 

Rev. 3.12 M – 11 
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33. The below information appears type y and hit Enter. 

 

 

 

34. You may receive the below information, if you do, hit Enter then continue to step 9. If 
not, continue to step 9. 

 

 

 

35. The below information will then appear, type y and hit Enter. 
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36. The below information will then appear, type n and hit Enter. 

 

 

 

37. You may receive the below information. If so, type y and hit Enter then continue to 
step 26. If not, continue to step 26. 

 

 

 

38. The below information appears, type in your specific server name and hit Enter. 

 

 

 

39. It will ask you to do the same thing, enter <CR> and hit Enter 

Note: CR = Carriage Return = Enter key 
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40. The below information will appear, type y and hit Enter. 

 

 

 

41. Once the installation is complete the system will take you to the system prompt, #, and 
show you the following information.  

Note: you will need to write down the path information for you will need it in the next 
section. 

 

 

 

42.  At the system prompt type the below command and hit Enter. 

 

 

 

 The below information should appear: 

 



Designing and Implementing HP Enterprise Backup Solutions 

M – 16 Rev. 3.12 
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43. Verify that the NetWorker daemons are running.  

At the system prompt, #, enter the below command and hit Enter.  

 

 

 

 The following information should appear: 

 

 

 

44. Change back to the root directory, unmount the CDROM, remove the NetWorker 6.0.1 
CD from the CDROM drive.  

At the system prompt, #, enter the below command and hit Enter. 

 

 

This completes the initial installation of Legato.



Designing and Implementing HP Enterprise Backup Solutions 

M – 18 Rev. 3.12 

Step 4 
Configuring the Profile 

 

45. Change to the root directory and edit the profile. 

At the system prompt, #, type,  

cd / and hit Enter.  

vi ./.profile and hit Enter.  

 

 

 

46. The profile window appears. 

Arrow down to the end of the path statement, next, hit the a key, and input the below 

information. 

:/usr/opt/networker/bin 
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47. Once entered, the completed path statement should look like what is shown below.  
Hit the Esc key to stop editing. Next, press the Shift key down and hit the z key twice. 
This will save the changes and close the vi session. 

 

 
 

48. Close all windows and logout and re-login to the system. This will invoke the changes 
you have made. 

  

This completes the configuration of the profile. 
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Step 5 
Removing the Default Tape device from the 

NetWorker Administration GUI 
 

49. Log back into the server, again using root as the User ID and Password. Next, open a 
Terminal window and load the NetWorker Administration GUI.  

At the system prompt, #, type the below command and hit the Enter key. 

 

 

 

50. The NetWorker Administration GUI appears.  

Click on Media, then Devices on the task bar. 

Note: Under devices, there is a device already listed. This is the default device. This 
device will need to be removed before configuring the tape drives.  
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51. The Devices window appears. Click on the device listed below and then click on 
Delete. 

 

 

 

52. The Notice window appears, click OK. 
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53. The Devices window appears once again. This time the Devices section is blank. Click 
on File and then Exit on the task bar. 

 

 

 

54. The NetWorker Administration GUI appears once more. It too shows that the device 
has been removed. Click on File then Exit on the task bar to close the window. This 
will take you back to the system prompt, #. 
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This completes the removal of the default device in the NetWorker Administration GUI
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Step 6 
Tape Drive Configuration Process 

 

55. Run the Juke Box Configuration file.  

At the system prompt, #, type the below command and hit Enter. 

 

57 

 

56. The below information will appear type 2 and hit Enter. 

 

58 

 

57. The below information will appear type 1 and hit Enter. 

Note: The TL891 /TL892 is seen as TL800 series and TL895 is seen as TL810 series. 

 

59 

 

58. The below information will appear, type in a name and hit Enter. 

Note: The naming convention that I use is the actual description of the device. 

 

60 
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59. The below information will appear, hit Enter. 

61 

60. The below information will appear, hit Enter. 

62 

61. The below information appears, type yes and hit Enter. 

63 

62.  If you do not know what the device name of your tape drives are, follow the next 
steps.   If you already know, skip to step 67. 

 

 

 

63. Minimize your current terminal window and open another terminal window. Next, run 
the command listed below. 
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64. The below information will show. Find your tape drive information and write it down, 
close the terminal and continue to step 67. 

 

 

 

65. The below information appears, hit Enter.  

 

 

 

66. The below information appears, type  /dev/ntape/tape??_d1 and hit Enter. 

Note: Your information may vary. Refer back to the information you wrote down on 
step 66. 

 

 

 

67. The below information will appear, type no and hit Enter. 
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68. The below information appears, type 14 and hit Enter. 

 

Repeat steps 67 – 70 for any additional tape drives. Make sure you change the tape 
number at the end of tape “/dev/ntape/tape??_d1 each time. 

When no more drives appear, continue to step 71. 

69. Once all drives are configured, the below information appears. Type yes and hit Enter. 

 

 



Installing and Configuring Legato NetWorker 6.0.1 for Tru64 5.1 

Rev. 3.12 M – 31 

70. The below information appears, type yes and hit the Enter key. 

 

 

 

71. The below information appears, type no and hit the Enter key.  

This will take you back to the system prompt, #. 

 

 

 

This completes the tape drive configuration process portion of the lab. 
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Step 7 
Labeling The Tapes  

 

Note: There are two ways to label the tapes. It can be done via a Terminal window or 
from the Networker Administration GUI. If you would like to perform to label the tape(s) 
from a Terminal window, continue to step 51. If you prefer to label tape(s) from the 
NetWorker Administrator GUI, skip to step 52. 

 

72. Minimize your current terminal window and open another Terminal window. 

At the system prompt, #, type nsrjb –L –Y –S ??-?? and hit Enter. Once complete you 
can close the window and proceed to step 60. 

 

Note: The ??-?? are the tapes that you want to be labeled. It takes several minutes per 
tape. You will not be prompted to do anything. Once complete, the system prompt, #, 
will once again appear. You can go ahead and run the NetWorker GUI to see what is 
going on. You may need to look to your storage device to find out what tapes are 
where. 

 

 

 

73. Open up another Terminal window and log in. 
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74. The NetWorker Administration GUI appears click Media and then Label from the task 
bar. 
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75. The Jukebox Labeling window appears. 

Enter the slot beginning number and the slot ending number of where the tapes reside. 
Leave all default settings and click on OK: 

 

Note: If you go this route, you will be prompted to overwrite the label for each tape. 

 

 

 

76. The notice screen appears, clock OK: 
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77. The Juke Box Labeling window reappears and it tells you in what stage of the process 
it is currently in. 

 

 

 

78. The notice window appears, click OK: 

Note: you will need to do this for each tape that you label. Close the window when all 
tapes are labeled. 
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79. Once the labeling of the tapes is complete, the Jukebox Labeling window will show 
that it is Finished Labeling Volumes. Close the window by clicking on cancel 
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80. The NetWorker Administrator GUI window appears. You may view what transpired 
during the labeling process under the Messages portion of the window. Close this 
window by clicking on file and exit on the task bar. 

 

  

 

This completes the labeling of the tapes portion of the lab



Designing and Implementing HP Enterprise Backup Solutions 

M – 38 Rev. 3.12 

 Step 8 
Performing a Selective Backup 

 

81. Bring up the NetWorker Backup GUI. 

At the system prompt, #, type the below command and hit Enter. 

 

 

 

82. The NetWorker Backup GUI appears.  It lists all the files and directories. Click on the 
files and or directories that you want to backup. Then click on the Start button. 

Note: For this exercise select only the Backup directory. 
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83. The Backup Options window appears, keep defaults and click OK: 

 

 

 

84. The Backup Status window appears. 

This will show you the status of you backup job. Once complete, click Cancel. 
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85. The NetWorker Backup GUI window appears. Close the NetWorker Backup GUI 
window by clicking on File then Exit on the task bar. 

 

 

 

This completes the selective backing up of files portion of the lab
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Step 9 
Performing a Selective Restore 

 

86. First, use File Manager to delete the directory. Click on Selected then Put in Trash, on 
the task bar. Once deleted, minimize File Manager. 

 

 

 

87. Bring up the NetWorker Recovery window.  

At the system prompt, #, type the command below and Enter. 
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88. The NetWorker Recovery window appears. Leave all defaults and click the Start 
button. 
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89. The Recovery Status window appears. It will show you the status of your recovery. 
When complete, click Cancel. 
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90. Close the NetWorker Recovery window.  

Click File and then Exit on the Task Bar. 
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91. Use File Manager to verify the directory has been recovered. 
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Step 10 
Performing a Full Backup  

 

92. Start the Networker GUI. If already started, go to step 41. 

At the system prompt, #, type the below command and hit the Enter key. 

 

 

 

93. The NetWorker GUI appears click Customize then Groups on the task bar. 
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94. The Groups window appears click on Create. Fill in the below information. Once 
complete, click on Apply at the bottom of the window. 

 

Name: “I would suggest naming it the start time that you are planning to use” 

Set Autostart to Enable 

Enter the Start Time 
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95. The group that you created should now be listed in the Groups window above Default. 
Click on File then Exit, on the task bar to close the window. 
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96. The NetWorker Administrator window appears, click Clients then Clients Setup on the 
task bar. 
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97. The Clients window appears, enter the below information and click on Apply. 

Note: The backup should start automatically if the scheduled time hasn’t 
been past. 

Once complete, go to the Restore Process. 

 

Browse policy – Week  

Retention policy – Week 

Directive – UNIX Standard Directives 

Group – “select your group” 
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98. Your changes that you made should now be shown. Click on File and Exit on the task 
bar to close the Clients window. 
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99. The NetWorker Administration GUI window appears. Once again you can view what 
is going on if you look at the messages section of this window. 

 

 

 

This completes the full backup process of the lab. 
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Step 11 
Performing a Full Restore 

 

100. F
irst, use File Manager and delete the backup directory. Once deleted, minimize File 
Manager. 
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101. O
n the Task Bar of the NetWorker’s Administrator window, click on Save Sets then 
Recover. 
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102. T
he Save Set Recover window appears, click on the set that you want to recover then 
click on Recover. 
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103. T
he Save Sets Recover Status window appears, select your recovery set and click on 
Start. 
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104. T
he Save Set Recovery File Conflict window appears, select Overwrite existing file and 
deselect prompt on further conflicts. 
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105. T
he Save Sets Recovery window appears. The Status section of the window shows what 
is taking place. Once the restore is complete, close the window by clicking on Cancel. 
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106. T
he Save Sets Recovery window appears, close it by clicking on File and Exit on the 
task bar. 
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107. O
pen up File Manager and verify that the backup directory has been restored. 
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108. T
he NetWorker Administrator window appears, click File then Exit on the task bar to 
close it. 

 

 

 

This completes the full restore portion of the lab. 
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STEP 12 
Uninstalling Legato NetWorker Off The Server. 

 

109. O
pen a Terminal window if needed. 

 

 

 

110. S
hut down the NetWorker daemons. 

At the system prompt, #, type the below command and hit the Enter key. 

Note: The –aq forces the system to shut down without prompting you for a 
response. 

 

 

  

111. T
he below information appears, type y and hit the Enter key. 
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112. D
etermine the NetWorker Subsets installed on your system. 

At the system prompt, #, type the below command and hit the Enter key. 

 

 

 

113. T
he following display appears 

 

 

 

114. R
emove your version of the NetWorker Software. 

At the system prompt, #, type the below command and hit the Enter key. 

 

 

 

115. T
he below information appears, type y and hit the Enter key. 
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116. T
he below information appears, type y and hit the Enter key. 

 

 

 

117. T
he below information appears, type y and hit the Enter key. 

 

 

 

118. T
he below information appears, type y and hit the Enter key. 
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119. T
he below information appears, type y and hit the Enter key. 
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120. The system prompt, # now appears.  
 

 

 

This completes the removal of Legato NetWorker off the server portion of the lab. 
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Installing and Configuring VERITAS NetBackup 
DataCenter 3.4 on Tru64 5.1 

Appendix N: Module 6 – Lab 1 

Objective: 
To install and configure VERITAS NetBackup DataCenter 3.4 on Tru64 5.1 for 
backup and restore 

Requirements: 
! AlphaServer 

! KGPSA-BC or KGPSA-CA host bus adapter 

This install is for a NetBackup master server (which by default is also a media 
server).  If you configure multiple servers in the NetBackup configuration the rest 
will be media servers.  
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Step 1 
Copying the Patch-Kit-3 Patch 

 

Note: The Tru64 UNIX operating system has patches that are released between major 
revisions. These patches either fix bugs or add enhancements. Tru64 5.1 patch kit 3 is 
a bundle of patches that are required and/or recommended as of today for Tru64 5.1. 
New patch kits are released as needed (usually quarterly). Patch kit 3 has a required 
enhancement for NetBackup 3.4.h 

 

1. Turn the Alpha server on. At the system prompt P000>> type b and hit Enter 

 

2. Log in as root with the password of root. 

 

3. Open a Terminal window and create a CDROM directory. 

 

   

 

4. Create a directory called home/os_patch/pk3 

 

 

 

5. Insert the Patch Kit 3 CD into the CDROM and mount it. 
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6. Copy the Patch Kit 3 file to /home/os_patch/pk3 directory. 

At the command prompt, #, type  

cp /cdrom/pk3/T64V51AS0003-20010413.tar home/os_patch/pk3 

 

 

 

7. Unmount the CDROM, remove the Patch Kit 3 CD from the CDROM drive.  

 

 

 

This completes the copying of the Patch Kit 3 file to the hard drive. 
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Step 2 
Installing the Patch Kit 3 Patch 

 

8. Take the system into Single User Mode. 

At the system prompt, #, type init s and hit Enter.  

 

 

 

9. Display the hard drive space in kilobytes. 

At the system prompt, #, type df –k and hit Enter. 

 

10. Mount all volumes of the hard drive. 

At the system prompt, #, type mount –a and hit Enter. 

 

11. Go into the home/os_patch/pk3 directory.  

At the system prompt, #, type cd /home/os_patch/pk3 and hit Enter. 

 

12. Tar the file.  

At the system prompt, #, type tar xvf T64* 

 

13. Go into the patch_kit subdirectory. 

 cd patch_kit 

 

14. Run the dupatch file 

At the system prompt, #, type ./dupatch 

 

14. Type the path where the patch_kit files are located. 
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/home/os_patch/pk3/patch_kit 

 

15. The system will ask Which option you would like to install? Choose Option 1, Patch 
install. Type 1 and hit Enter. 

Note: Throughout the installation of the patch, the system will notify you on what is 
happening. It will then prompt you to hit Enter to continue. You may want to take the 
time to read the screen to get a better understanding on what is going on, if not, just hit 
Enter each time. 

 

16. The system will also prompt you again, for which option you would like to choose. 
For this lab, choose option 2, Check and Install. Type 2 and hit Enter. 

Note: In a real life environment, you would choose Option 1 first, once that completes 
and passes, then choose Option 2. 

 

17. The system will ask if you want to allow the volume to be reversible, state yes. Type 
yes and hit Enter. 

Note: Stating yes will allow you and or the customer to uninstall Patch Kit 3 Patch. 
This however, takes up a lot of disk space. Your customer may not want to do this. 

 

18. The system will request a name. Type in your name and hit Enter.  

 

19. The system will then ask for comment. You may want to type something in to the 
effect of I installed this patch kit to get the enhancements required for NetBackup 3.4 
and hit Enter. 

 

20. The system will list all the patches it has to offer. Scroll down to the bottom and select 
the number to install all patches. Type the number in and hit Enter. 

Note: If the system finds a patch that it cannot install, tell it to continue with out it.  

 

21. The system will ask Do you have a pre-existing configuration file? Type yes and hit 
Enter. 

 

22. The system will request for you to Enter the name of the pre-existing configuration 
file or hit return to you “your server name”. Mine was ALPHASEVEN. Hit Enter to 
continue. 

 

23. The system will ask Do you want to edit the configuration file. Type n and hit Enter. 
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24. The system will ask do you want to reboot now? Type y and hit Enter. 

 

25. Once the system reboots, it will take you back to the Log in prompt.  

 

This completes the installation of the Patch Kit 3 portion of the lab. 
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Step 3 
NetBackup Installation 

 

26. While at the Login Prompt, type root for the User and root for the password. 

 

27. Insert the NetBackup CD into the cdrom and mount it. 

 

 

 

28. Change to the cdrom directory and run the NetBackup Install script. 

 

 

 

29. The Veritas Installation Script appears, select the NetBackup option. 
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30. Do you want to install NetBackup Media Manager Files? 

 

 

 

31. Is it okay to install NetBackup in /usr/openv/netbackup? 

 

 

 

32. Is it okay to install Media Manager in /usr/openv/volmgr? 

 

 

 

33. Do you want to load any Other NetBackup Clients onto the server? 

Note: This is optional the customer may want to install other clients onto the server. 
For this lab, we will choose not to install the clients. 
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34. Enter the license key. You will need to get the license key from the instructor. 

Note: The license key is not case sensitive. 

 

 

 

35. Is alphaseven the master server?  

Note: alphaseven is the example; you will use what ever the name of your server is. 

 

 

 

36. Do you have a media or slave server?  

Note: There may be a media or slave server in a real life application, for this 
installation we will say no. 
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37. The system will state  

To change theses entries modify the file /tmp/services.ov_edited.1688 and enter 
<RETURN> when ready to continue. Hit Enter to continue. 

 

 

 

38. Hit Enter for Host global device info. 

Note: This may fail; if so, you will need to enter it by hand later in the installation 
procedure. See steps ?? - ?? for the fix. The may be fixed in a later release or patch. 
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39. Do you want to install client software? 

 

 

 

40. Do you want to create class and schedule? 

 

 

 

41. Do you want to start NetBackup BPRD process? For this lab, we will answer yes to the 
question. 

Note: It doesn’t matter if you answer yes or no to this step.  

 

 

 

42. Do you want to index the client database? 

Note: The index is but a matter of preference. It does take up more space on the hard 
drive. If you tell it yes then continue to step 19. If you tell it no, skip to step 20. 
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43. Do you want to use the default index level? 

 

 

 

44. Do you want to add additional license keys now? 

 

 

 

45. Quit NetBackup Install Script after the installation completes. 

 

 

 

46. Note: An install trace can be found under the tmp directory. This will show you 
everything that has transpired during the installation. This may be useful in 
troubleshooting. 
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47. Unmount the CDROM. 

Type cd / and hit Enter. 

Type umount /cdrom and hit Enter. 

Push the Eject button on the CDROM drive to remove the CDROM. 

 

 

 

This completes the initial Installation of NetBackup Portion of the Lab. 
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Step 4 
Configuring the Profile 

 

48. Add NetBackup binary directories to the root user path by adding the following paths 
to the PATH line of the ../profile file. 

 

At the system prompt, #, type, vi ./.profile and hit Enter.  

 

 

 
49. The profile window appears. 

Arrow down to the end of the path statement. Hit the a key, input the below 
information. 
:/usr/openv/volmgr/bin:/usr/openv/netbackup/bin:/usr/openv/netbackup/bin/goodies:/u
sr/openv/netbackup/bin/admincmd 
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50. Once entered, the completed path statement should look like what is shown below.  
Hit the Esc key to stop editing. Next, press the Shift key down and hit the z key twice. 
This will save the changes and close the vi session.     

 

 
 

51. Close all windows and logout and re-login to the system. This will invoke the changes 
you have made. 

  

This completes the Configuration of the Profile portion of the Lab. 
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Step 5 
NetBackup Patch – J0850646 Installation 

 

52. Mount the NetBackup Patch CDROM by placing it into the CDROM drive and issuing 
the mount command. 

 

 

 

53. Create a patches subdirectory 

Type mkdir veritas_patches and hit Enter. 

 

 

 

54. Copy the Vrts_patch.install, patchJ0850646.alpha.tar.Z, and the 
patchJ0850646.README from CDROM to / veritas_patches directory. 

Type the commands listed below and hit Enter after each. 

Note: You may need to copy it off the server. If so, look to instructor for information. 
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55. Go to patches subdirectory. 

Type cd /veritas_patches and hit Enter. 

 

 

 

 

56. Start the patch installation. 

Type ./Vrts_patch.install and hit Enter. 

 

 

 

57. Enter the patch name. 

Type J0850646 and hit Enter. 

Note: this initiates the patch installation. 

 

 

 

58. The system will ask you once again, which patch you would like to install. The 
installation is now complete, type q and hit Enter to exit the installation program. This 
will take you back to the system prompt, #. 
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59. Unmount the CDROM and remove the NetBackup Patch – J0850646 cd. 

Type umount /cdrom and hit Enter. 

 

 

 

This completes the NetBackup Patch – J0850646 Installation portion of the Lab. 
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Step 6 
Auto-configuration of the system 

 

60. Verify which NetBackup processes are active. 

Type bpps -a and hit Enter. 

Note: If vmd under mm Process is shown, then skip to step 61. If it is not listed, 
continue with step 58. 

 

 

 

61. Stop the NetBackup application. 

Type K77netbackup and hit Enter 

 

 

 

62. See what is running. 

Type bpps –a and hit Enter 
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63. Start NetBackup application 

Type S77netbackup and hit Enter. 

Note: You will receive the message No Entries in the Drive Database. This is normal 
for none have been set up. You will need to hit the Enter key once more to get to the 
system prompt, #. 

 

 

 

64. Check to see if the Global DB Hostname has been set. Type the below command and 
hit Enter.  

 

 

65. Set the Global DB Hostname. Type in the below command with the name of your 
server. 

 

 

 

66. vmglob –listall 

Note: There shouldn’t be anything here, for it hasn’t been configured. 
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67. Tell the system to auto config its self. Run the below command. Once completed, the 
bottom portion should look something like what is shown below. 

At the system prompt, #, type tpautoconf –a –v and hit Enter. 

Note: This may take a while to complete. 

 

 

 

 

68. Verify which NetBackup processes are active. 

Type bpps -a and hit Enter. 

 

 

 

69. Stop the NetBackup application. 

Type K77netbackup and hit Enter 
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70. Start NetBackup application 

Type S77netbackup and hit Enter. 

 

 

71. Check to see which NetBackup Processes are now running. 

At the system prompt, #, type bpps –a and hit Enter. 

 

 

 

This completes the Auto-Configuration portion of the Lab. 
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Step 7 
Modifying the bp.conf file 

 

72. Go to the /usr/openv/netbackup directory. 

At the system prompt, #, type cd /usr/openv/netbackup and hit Enter. 

 

 

 

73. Now edit the bp.conf file. 

At the system prompt, #, type vi bp.conf and hit Enter.  
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74. The bp.conf file appears. Arrow down to the last line and type the letter a to append the file. Next, arrow to the end 
of the line and hit Enter. Type the below information in the window.  

MUST_USE_LOCAL_DRIVE = YES 

ALLOW_MEDIA_OVERWRITE = DBR 

ALLOW_MEDIA_OVERWRITE = TAR 

ALLOW_MEDIA_OVERWRITE = CPIO 

ALLOW_MEDIA_OVERWRITE = ANSI 

ALLOW_MEDIA_OVERWRITE = AOS/VS 

ALLOW_MEDIA_OVERWRITE = MTF1 

ALLOW_MULTIPLE_RETENTIONS_PER_MEDIA = YES 

 

 

 

75. Once the information has been entered, press the Shift key down and hit the letter z twice. This will save the 
modifications, close the file and take you back to a system prompt, #. 
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This completes the modifications to the bp.conf file. 

Step 8 
Creating a Size Data Buffer File 

 

76. Go into the /usr/openv/netbackup/db/config directory, if not already in there.  

At the system prompt, #, cd /usr/openv/netbackup/db and hit Enter. 

 

 

 

77. Create a file SIZE_DATA_BUFFERS.  

At the system prompt, #, type vi SIZE_DATA_BUFFERS and hit Enter. 

 



Designing and Implementing HP Enterprise Backup Solutions 

N – 34 Rev. 3.12 

 

 

78. The SIZE_DATA_BUFFERS appears. There is currently nothing in it. Input the value 
for 64MB into it. 

At the cursor, do the following: 

Hit the letter a on the keyboard. This is to edit and append the file. 

Type 65536 
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79. The SIZE_DATA_BUFFERS file should now show the value of 65536 in it. 

Hit the Esc key on the keyboard. This will exit the edit mode. Press the Shift key down 
on the keyboard and hit the letter z twice. This will save and exit the file. Once 
complete, close the terminal window.  

Note: This will help the system’s performance. 

 

 

 

80. You will now be at a system prompt, #. 

 

 

 

This completes the creation of the Size Data Buffer File portion of the lab 
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Step 9 
Running and Configuring the NetBackup GUI 

 

81. Load the NetBackup GUI.  

At the system prompt, #, type xnb $ and hit Enter. 

 

 

 

82. The NetBackup GUI window appears  

 

 

 

83. Click on the Device Management button. 
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84. The Device Management window appears. Verify that your server, your robot, and 
your drives are shown. Next, close the window by clicking on File and Exit on the task 
bar. 

 

 

 

85. Click on the Media Management button.  
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86. The Media Management window appears. Click on Robots and then Barcode Rules on 
the task bar.  

 

 

 

87. The Barcode Rules window appears click on New. 
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88. The Creating Barcode Rules window appears enter the below information: 

Barcode Tab – cln 

Media Type – DLT cleaning tape 

Cleanings – 25   

Once the information is entered, click on OK. 

Note: DLT7000 is cleaning tape media type DLT cleaning tape.  DLT8000 is cleaning 
tape media type DLT cleaning tape. 

 

 

 

89. The Barcode Rules window appears once more. It shows the information you entered. 
Click on Close to close the window. 
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90. The Media Management window appears. Click on Robots and then Use Inventory to 
update Volume Configuration on the task bar. 

 

 

 

91. The Robot Inventory window appears.  
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92. Click on Update Volume Configuration. The system will start displaying the results 
under the Results portion of the Robot Inventory window. 
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93. The Yes or No Update Volume Configuration window appears. Click Yes. 

 

 

 

94. The system will then update the Volume Configuration. Once complete, click on close. 
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95. The Media Management window appears. It now shows the updated Volume 
Information. Click on File and then Exit on the task bar. 

Note: If you are going to be in a Multihost Environment (multiple NetBackup media 
servers) continue to step 84, if not, skip to step 88. 
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96.  Click on the Device Management button. 
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97. The Device Management window appears. Look to the lower portion of the split 
screen and select a drive and then right click on it. Select Update Drive. 

 

 

 

98. The Update Drive window appears. Find and select the Multihosted drive option and 
click on OK to accept the setting and close the screen. 
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99. The message screen appears, click on OK: 

Note: You will need to repeat Steps 85 through 87 for each drive, once complete click 
on File then Exit on the task bar. 

 

 

 

100.Click on the Backup Management button. 
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101.The NetBackup Administration window appears. Click on Actions, New, and Storage 
Units. 
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102.The Adding a Storage Unit window appears. Enter the below information into the 
window, once complete, click OK. 

Storage unit Name – TL891-2  “The name should describe the configuration”  

Robot Type – TLD – Tape Library DLT 

Density – dlt – DLT Cartridge 

Robot Number – 1 

Number of Drives – 2 
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103.The NetBackup Administration window appears. Click on Actions, new, and Classes. 

 

 

 

104.The Creating a New Class window appears. Enter the below information into the 
window, once complete, click OK. 

Class Name – TL89-2  “Your Choice” 
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105.Changing class TL891-2 window appears. With Attributes selected. Enter the below 
information into the window, once complete, click on Clients. 

Class Type – Standard 

Class Storage Unit – TL891-2 

Class Volume – NetBackup  

Max Jobs Per Class – 10  

Class Priority – 0  

Make sure Active is selected. 
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106.The Clients window appears. Click on New.  

 

 

 

107.The Adding Clients window appears. Enter the below information, once complete, 
click OK. 

Hardware and Operating System – Alpha OSF1_V4 

Client Names – alphaseven 
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108.The Changing Class TL891-2 window appears. It now shows the client, alphaseven. 
Now, select Schedules. 

 

 

 

109.The Schedules window appears. Click on New. 

 

 

 

110.The Creating a Schedule window appears. Enter the below information and click OK. 

Name of Schedule – TL891-2_full 
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111.The Creating Schedules TL891-2_full of Class alphaseven window appears. Enter and 
or select the below information and click OK. 

Override Class Storage Unit – No 

Override Class Volume Pools – No 

Type of Backup – Full Backup 

Retention Period – 1 Week 

Frequency – 1 Hours 

 Note: These selections may differ in a real live environment. 
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112.The Changing Class TL891-2 window appears. It now shows the client, TL891-2_full, 
and it’s Schedules. Click on Files. 

 

 

 

113. The Files window appears. Enter ALL_LOCAL_DRIVES and click on OK. 

Note: This tells the client to backup all of the local disk drives. 
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114.The NetBackup Administration window appears. It now displays the information that 
has been entered. Click on File and Exit on the task bar to close this window. 

 

 

 

This completes the Running and Configuration of the NetBackup GUI portion of 
the Lab. 



Installing and Configuring VERITAS NetBackup DataCenter 3.4 on Tru64 5.1 

Rev. 3.12 N – 61 

 Step 10 
Running a Manual Backup 

 

115.The NetBackup GUI window appears. Close this application. Click File and then Exit 
on the task bar. 

 

 

 

116.Using the Terminal session that was used to launch the NetBackup GUI, Check to see 
which NetBackup Sessions are currently running. 
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117.Stop the  NetBackup sessions. 

At the system prompt, #, type K77netbackup and hit Enter. 

 

 

 

118.Start NetBackup 

At the system prompt, #, type S77netbackup and hit Enter. 

 

 

 

119.Check to see which NetBackup Processes are now running. 

At the system prompt, #, type bpps –a and hit Enter. 

Note: They should be the same as the ones listed below. 

 

 

 

120.Using the same Terminal session, start the NetBackup GUI. Run the below 
Command. xnb $ 
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121.The NetBackup GUI window appears.  

 

 

 

122.Click on the Backup Management button on the NetBackup GUI. 
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123.The NetBackup Administration window appears. 

Situate the NetBackup Administration window so that you still have access to 
the NetBackup GUI. 
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124.On the NetBackup Administration window, under classes, Right Click on the storage 
device name TL891-2 you created and click on Manual Backup. 

 

 

 

The Manual Backup of Class TL891-2 window appears. Select the Schedule and the Client 
that you want to use click OK to start the manual backup.  
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125.Click on the Activity Monitor button on the NetBackup GUI. 

 

 

 

 

126.The Job Monitor window appears. Click on View and Columns. 
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127.The Columns Jobs window appears. Select only what is listed below. Once selected, 
click on Apply then OK. 

Note: You may need to scroll down and unselect some other items. 

Job Type, status, Client, Media Server, Started, Elapsed, Try, Operation, K 
Bytes, % Complete.  
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128.The Job Monitor will show you the status of the Manual Backup. Once the backup is 
complete close all windows except for the NetBackup GUI. 
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This completes the Manual Backup portion of the lab. 
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Step 11 
Delete the veritas_patches Directory 

 

129. Open a File Manager window and find, select, and delete the /veritas_patches directory. Do this by 
selecting the /veritas_patches directory then click on Selected and Put In Trash on the task bar. 

 

 

 

130.  File Manager will now show that the /veritas_patches directory is no longer there. Click File and then 
Close on the task bar to close File Manager. 
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This Completes the Deletion of the veritas_patches directory portion of the lab. 
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Step 12 
Running a Manual Restore 

 

131.Click on the User Backup and Restore Button on the NetBackup GUI. 

 

 

 

132.The xbp window appears, click on file then Browse file systems for (Backup or 
Archive) on the task bar.  

Note: The default directory is whatever directory you were in when you launched the 
NetBackup GUI. 
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133.You may receive the below message window. If so, click Close and proceed to step 
132. If not, proceed to step 132. 

 

 

 

134.The xbp window will display all of backup images that have been completed. Select 
the Backup Image, under the Backup Image portion of the windows, that you want to 
use and then click on Edit and Update Display, on the task bar, to view the 
information backed up. 
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135.The xbp window will display all directories and files that have been backed up. Select 
the directory and files that you want to restore. For this lab we will select the 
/veritas_patches directory and all the files underneath. Next, click on Restore and 
Restore Selected Files and Directories on the task bar. 
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136.The xbp_Confirm window appears. It shows what is to be restored. Click OK. 
Depending on the situation, you may or may not want to select Overwrite the Existing 
File.  

 

 

 

137.If not already opened, open the Job Monitor window to check the status of the 
Restore Job. Click on View and Column. 
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138.You will also need to reinitialize the settings on the Job Monitor window. The 
Columns Jobs window appears. Select only what is listed below. Once selected, click 
on Apply then OK. 

Note: You may need to scroll down and unselect some other items. 

Job Type, status, Client, Media Server, Started, Elapsed, Try, Operation, K Bytes, % 
Complete.  
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139.You will be back at the Job Monitor window. Again, you can observe the status of 
your Restore Job from here. Use File Manager to verify that the directory and files 
are back 

 

 

 

 

 

This completes the Restore Portion of the Lab.
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Step 13 

Removing NetBackup From the Server 
 

140.Close all Windows except for an active terminal. Next, stop the active NetBackup 
process.  

At the system prompt, #, and type K77netbackup and hit Enter. 

 

 

 

141.Open File Manager and remove the /usr/openv directory and all its contents (or the 
directory where you installed NetBackup. 

 

 

 

142.A warning window will appear. Click OK. 
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143.Use File Manager to find and remove the K77netbackup. 

Note: It can be found under the /sbin/rc0.d/ directory.  

 

 

 

144.Use File Manager to find and remove the S77netbackup. 

Note: It can be found under the /sbin/rc3.d/ directory.  
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145.Use File Manager to find and remove the /veritas_patches directory. 

 

 

 

146.Use File Manager to find and remove the services file. 

Note: It can be found under the /etc/ directory.  
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147.Select the services.NBU_050301_11.41.25 file and click on the wording. Next change 
the wording to read just services and hit Enter.  

Note: The date may be different. Make sure the saved file is the original without the 
NetBackup modifications. 

 

 

 

The directory should now only show a single services file. Once complete, Close File 
Manager along with all other windows and Log Out of the system. 
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This completes the removal of NetBackup off the system. 
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Installing and Configuring Tivoli Storage Manager 
4.1.3  

for Solaris 7 
Appendix Q: Module 6 – Lab 1 

 

Objective 
After completing this module, you will be able to install, configure, perform a 
backup, perform a restore, and uninstall Legato NetWorker for Solaris. 
 

Requirements 
! Tivoli 4.1 and 4.1.3 Patch  

! Solaris 2.7 and 7_recommended Patch 

! 128MB RAM at least 

! 500 MB free disk space for NetWorker software 

! Enough free disk space to allow for 5% of total backup data (allow for up to 
3 times the index size during software update conversion) 

 
 

Before you install 
        Make sure the Solaris operating system sees all hardware. 
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Step 1 
Creating the Patches Directory Structure. 
 

1. Turn on your computer, the Sun Solaris program will load and will ask you to enter 
your user name. Type, in lower case, root, hit Enter. 

 

2. The system will then ask you to enter your password. Type, in lower case, root, hit 
Enter. 

 

3. The Introducing Your Desktop window appears, close this window. 
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4. The File Manager window appears, close the File Manager window.  

 

 

 

5. Open a Command Console window. 
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6. The Command Console window appears. Create a directory called Patches.  

At the command prompt, #, type the below command and hit Enter  

mkdir Patches  

 

 

 

7. Create a Tivoli, a Compaq, and a Solaris subdirectory under the Patches directory. 

At the command prompt, #, type: 

cd /Patches and hit the Enter key. 

mkdir Tivoli and hit the Enter key. 

mkdir Compaq and hit the Enter key. 

mkdir Solaris and hit the Enter key. 

 

 

 

8. Go into the Compaq Subdirectory and create a FCRAID subdirectory under it. 

At the command prompt, #, type the commands below and hit Enter after each. 
cd Compaq  

mkdir FCRAID  
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9. Go into the Tivoli Subdirectory and create a Server and a Client subdirectory under it. 

At the command prompt, #, type the commands below and hit Enter after 
each. 

cd ..  

cd Tivoli  

mkdir Server  

mkdir Client  

 

 

 

This completes the creation of the Patches directory structure. 
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Step 2 
 Copying over the Patch Files from the Master Server  

 

10. Go into the Server subdirectory of Tivoli. 

At the command prompt, #, type: 

cd Server and hit the Enter key. 

Note: You are currently in the /Patches/Tivoli directory 

 

 

 

11. To connect to the Master Server you will need to FTP over to it.  

At the command prompt type the below command and hit Enter 

ftp 192.168.1.12 or the IP address of the master server 

 

 

 

12. The system will ask you to log in to the Master Server.  

At the Command prompt, ftp>, type: 

root and hit the Enter key. 
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13. The system will ask you for the password. 

At the Command prompt, ftp>, type the below command and hit Enter 

Root or the password for root 

 

 

 

14. The ftp> prompt now appears.   

 

 

 

15. Using your computer, go into the /Patches/Tivoli/Server directory on the Master 
Server.  

Note: You are currently on the Master Server. 

At the command prompt, ftp>, type 

cd /Patches/Tivoli/Server and hit the Enter key. 
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16. Check to see what files are currently in the /Patches/Tivoli/Server directory on the 
Master Server. 

At the command prompt, ftp>, type: 

dir and hit the Enter key.  

 

 

 

17. Set the system into Binary mode. This is so that it receives the files correctly. 

At the command prompt, ftp>, type: 

bin and hit the Enter key. 

 

 

 



Installing and Configuring Tivoli Storage Manager 4.1.3 for Solaris 7 

Rev. 3.12 Q – 11 

18. Copy the file TSM4130_Sun.tar, from the /Patches/Tivoli/Server directory on the 
Master Server, into the /Patches/Tivoli/Server directory on your machine.  

At the command prompt, ftp>, type: 

get TSM4130_Sun.tar and hit the Enter key. 

 

 

 

19. Change from the /Patches/Tivoli/Server directory on your machine to the 
/Patches/Tivoli directory. 

At the command prompt, ftp>, type: 

lcd .. and hit the Enter key. 

 

 

 

20. Change from the /Patches/Tivoli directory on your machine to the 
/Patches/Tivoli/Client directory. 

At the Command prompt, ftp>, type: 

lcd Client and hit the Enter key. 
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21. Change from the /Patches/Tivoli/Server directory on the Master Server to the 
/Patches/Tivoli directory. 

At the Command prompt, ftp>, type: 

cd .. and hit the Enter key. 

 

 

 

22. Change from the /Patches/Tivoli directory on the Master Server to the 
/Patches/Tivoli/Client directory. 

At the Command prompt, ftp>, type: 

cd Client and hit the Enter key. 
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23. Check to see what files are currently in the /Patches/Tivoli/Client directory on the 
Master Server. 

At the Command prompt, ftp>, type: 

 dir and hit the Enter key. 

 

 

 

24. Set the system into Binary mode. 

At the Command prompt, ftp>, type: 

bin and hit the Enter key. 
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25. Copy over the file IP22150.TAR, from the /Patches/Tivoli/Client directory on the 
Master Server, into the /Patches/Tivoli/Client directory on your machine. 

At the Command prompt, ftp>, type: 

get IP22150.tar and hit the Enter key. 

 

 

 

26. Change back to the /Patches/Compaq/FCRAID directory on your machine. 

At the command prompt, ftp>, type: 

lcd /Patches/Compaq/FCRAID hit Enter. 

 

 

 

27. Go into the /Patches/Compaq/FCRAID directory on the Master Server. 

At the command prompt, ftp>, type: 

cd  /Patches/Compaq/FCRAID hit Enter. 
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28. Check to see what files are currently in the /Patches/Compaq/FCRAID directory on 
the Master Server. 

At the Command prompt, ftp>, type: 

dir hit Enter. 

 

 

 

29. Once again make sure the system is in Binary mode. 

At the command prompt, #, type: 

bin and hit the Enter key. 
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30. Now copy the fcraid_v2.3c_rel.tar from the /Patches/Compaq/FCRAID directory on 
the Master Server to the /Patches/Compaq/FCRAID on your machine 

 

 

 

31. Drop the connection to the Master Server. 

At the Command prompt, ftp>, type: 

quit and hit the Enter key. 

 

 

 

32. Go into the /Patches/Compaq/FCRAID directory on your machine. 

At the Command prompt, #, type: 

cd /Patches/Compaq/FCRAID and hit the Enter key. 

 

 

 

33. Check to see what files are currently in the /Patches/Compaq/FCRAID directory. 

At the Command prompt, #, type 

ls, and hit the Enter key.  
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34. Insert the Patches CD into the cdrom drive. The File Manager window appears.  

 

 

 

35. Find the 7_recommended patch under the /Patches/Solaris directory on the Patches 
CD. Select it and then click on Selected and Copy to... 
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36. The Copy Object window appears. Type in the Path where you want to copy the file 
and click OK.  

 

 

 

This Completes the Copying over of Patch files into the Patches directories
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Step 3 

Installing the 7_reccomended Patch 
 

37. Open a Console window if one is not available 

Note: Each Solaris Operating system has its own Patch. Solaris 7 has 7_recommended and Solaris 8 
has 8_recommended. 

 

 

 

38. The console window appears. Go into the /Patches/Solaris directory and unzip the 7_recommended.zip 
file. 
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39.  Change directories to the 7_Recommended directory and run the Cluster install. 
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40. The below window appears, type y and hit enter. 

Note: You may see errors during the installation. This is normal for the system is looking for software 
packages that you have not installed or needed to install.. 

 

 

 

41. Once complete, the system will take you to a system prompt, #. Tell the system to reboot. 

 

 

 

This completes the installation of the 7_recommended patch 

 



Designing and Implementing HP Enterprise Backup Solutions 

Q – 24 Rev. 3.12 

Step 4 
Installing the HBA driver 

 

42. Go into the /Patches/Compaq/FCRAID directory on your machine and expand the 
fcraid_v2.3c_rel.tar file. 

At the command prompt, #, type tar xvf fcraid_v2.3c_rel.tar and hit the Enter key. 

 

 

 

43. Now get a list of the packages available for installation.  

Note: We are looking for the HBA driver package. 

At the command prompt, #, type: 

 pkgadd -d . and hit the Enter key. 

 

 

 

44. The list of available packages appears type 2 and hit the Enter Key. 
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45. The system will then ask you to Select Mode: Fabric or Arbitrated Loop type F and 
hit the Enter key. 

 

 

 

46. The following statement appears, type y and hit Enter.  
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47. Once the installation is complete, the system will list the available packages again. 
Type “q” and hit the Enter key. 

 

 

 

Note: The TSM4130_Sun.tar has been copied over to the /Patches/Tivoli/Server directory, 
the IP22150.tar has been copied to the /Patches/Tivoli/Client directory, and the 
fcraid_v2.3c_rel.tar has been copied to the /Patches/Compaq/FCRAID directory and 
installed. 

 

This Completes Installing the HBA Drivers 
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 Step 5 
Initial Installation of Tivoli 4.1.0 

 

48. Insert the TSM CD into the CDROM drive. In the Console window type the following 
command: 

 /usr/sbin/pkgadd –d /cdrom/cdrom0 then hit the Enter key. 

 

 

 

49. The list of available packages appears. Enter the number that corresponds to the server 
packages that you want to install then hit Enter. 

 

Note: Install all of the packages except the TIVsmChsm. HSM is not currently 
supported by Compaq. 
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50. The below statement appears, type y and hit Enter  

Do you want to create the directory? 

 </opt/tivoli/tsm/client> 

 

 

 

51. The below statement appears, type y and hit Enter 

 

 
 

52. The below statement appears, type y and hit Enter 

 

 

 

53. The below statement appears, type y and hit Enter 
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54. The following statement appears, type y and hit Enter 

 

 

 

55. The following statement appears, type y and hit Enter 

 

 

 

56. The following statement appears, type y and hit Enter  
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57. Once complete, the system will again ask which packages to install. Type “q” hit 
Enter. 

 

 

 

58. Eject the CD-ROM and remove the CD from it. 

At the command prompt, #, type the below commands and hit enter after each. 

 

 

 

This completes the initial installation of Tivoli 
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Step 6 
Uninstalling Tivoli 4.1.0 

 

59. Check to see which Tivoli packages are currently installed. 

At the command prompt, type: 

pkginfo | grep TIV and hit Enter. 

Note: The window will display the list of server packages that are installed. 

 

 

 

60. Remove everything except TIVsmCdoc and TIVsmSlic.  

At the command prompt, #, type:  

pkgrm TIVsmCapi TIVsmCba TIVsmS TIVsmSdev and hit Enter.  

 

Note: You can remove one or more server packages at the same time. 

  

 

 

61. The following statement appears, type y and hit Enter. 
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62. The following statement appears, type y and hit Enter. 

 

 
 

63. The following statement appears type y and hit Enter. 

 

 

 

64. The following statement appears type y and hit Enter. 
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65. The following statement appears type y and hit Enter.  
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66. The following statement appears type y and hit Enter. 

 

 

 

67. The following statement appears type y and hit Enter. 

 

 
 

68. Once the removals of the packages are complete the system will take you to the 
command prompt, #. 

 

 

 

This completes the uninstallation of Tivoli portion of the lab. 
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Step 7 
Installing the Tivoli Patch 4.1.3 

 

69. Check to verify which directory you are currently in. 

At the command prompt, #, type: 

pwd and hit Enter. 

  

 

 

70. Go into the /Patches/Tivoli/Server directory on your computer. 

At the command prompt, #, type: 

cd /Patches/Tivoli/Server and hit Enter. 

 

 

 

71. Check to see what files are currently in the /Patches/Tivoli/Server directory. 

At the command prompt, #, type: 

ls and hit Enter. 
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72. Expand the TSM4130_Sun.tar into the /Patches/Tivoli/Server directory to your 
computer. 

At the command prompt, #, type:  

tar xvf tsm4130_Sun.tar and hit Enter. 

 

 

 

73. Uncompress the file TSM4130S_Sun.pkg.Z in the /Patches/Tivoli/Server directory. 

At the command prompt, #, type: 

uncompress TSM4130S_Sun.pkg.Z and hit Enter. 

 

 

 

74. Check to see what files decompressed in the /Patches/Tivoli/Server directory. 

At the command prompt, #, type: 

ls and hit Enter. 
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75. Check to see what Server packages you have available to install. 

At the command prompt, #, type: 

pkgadd –d TSM4130S_Sun.pkg and hit Enter.  

 

 

 

76. It will ask you what server packages you want to install, the default is all, so hit Enter. 

 

 

 

77. The following statement appears type y and hit Enter. 

 

 

 

78. The following statement appears type y and hit Enter. 
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    79. Once the installation is complete, the system will take you to the system prompt, #. 

 

 

 

80. Go to the /Patches/Tivoli/Client directory on your machine and to list the files in that 
directory.  

At the command prompt, #, type 

cd /Patches/Tivoli/Client and hit Enter. 

ls and hit Enter 

 

 

 

81. Expand the IP22150.tar file in the /Patches/Tivoli/Client directory. 

At the command prompt, #, type: 

tar xvf IP22150.tar and hit Enter. 
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82. View the files listed in the /Patches/Tivoli/Client directory on you machine. 

At the command prompt, #, type 

ls and hit Enter 
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83. Check to see what files decompressed in the /Patches/Tivoli/Client directory. 

At the command prompt, #, type: 

pkgadd –d . and hit Enter. 

 

 

 

84. The list of available packages will appear. Select only TIVsmCapi and TIVsmCba. 
Type 1 2 and hit Enter. 

 

 

 

85. The following statement appears type y and hit Enter. 
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86. The following statement appears type y and hit Enter. 

 

 

 

87. The following statement appears type y and hit Enter. 

 

 
 

88. The following statement appears type y and hit Enter. 
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89. The list of available packages will appear again. Type “q”, and hit Enter to quit. This 
will take you back to the system prompt, #. 

 

 

 

This Completes the Installation of the Tivoli patch 
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Step 8 
HBA Configuration 

 

90. Go into the patches directory  

At the system prompt, #, type 

cd /Patches and hit Enter. 

 

 

 

91. View the information in the directory. 

At the system prompt, #, type 

ls –al and hit Enter.  

 

 

 

92. Notice that the status of the hba_conf_sol file. It is read only. We need to modify it so 
we can run the file. 

At the system prompt, #, type 

chmod 777 hba_conf_sol and hit Enter. 
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93. View the information in the Patches directory once again. 

At the system prompt, #, type 

ls –al and hit Enter. 

 

 

 

94. Run the hba_conf_sol file. 

At the system prompt, #, type 

./hba_conf_sol and hit Enter. 

 

 

 

95. The information below appears. 

Type 1 at the prompt and hit Enter. 

 



Installing and Configuring Tivoli Storage Manager 4.1.3 for Solaris 7 

Rev. 3.12 Q – 49 
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96. The information below appears. 

Type 1 at the prompt and hit Enter. 

Note: your WWPN number may be different than what is shown here. 

 

 

 

97. The below information appears. You will want to copy this information. Highlight the 
information then select Edit and then Copy on the task bar. 
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98. Use the Text Editor to find and edit the mt.conf file. 

Note: it is located in the /usr/kernel/drv directory. 
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99. Place the copied information into the file.  

Change the “st” to “mt”, set the system lun= information from lun=0 … lun=7, and 
then save the file. 
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100.Use the Text Editor to find and edit the lb.conf file. 

Note: it is located in the /usr/kernel/drv directory. 
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101.Use the Text Editor and enter the same information that you entered into the mt.conf 
file.  

Change the “st” to “lb”, set the system lun= information from lun=0 … lun=7, and 
then save the file and close the Text Editor. 

 

 

 

102.Use the Text Editor to find and edit the st.conf file in the /kernel/drv directory. You 
will need to either comment out the information at the bottom or delete it.  
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103.Now reboot the machine for the changes to take place. 

At the system prompt, #, type the below command and hit Enter. 

reboot -- -r  

 

 

 

104.Once the system reboots, log back in and open a console window, if need, and run the 
below commands at the system prompt, #, and hit Enter. 

add_drv –m ‘* 0666 bin bin’ /usr/kernel/drv/mt 

add_drv –m ‘* 0666 bin bin’ /usr/kernel/drv/lb 

 

 

 

 

 

105.View the messages log to find out where the motor and the libraries are. 

At the system prompt, #, type 

cd /var/adm and hit Enter 

cat messages 

Note: in this example, the robot is 4 and drives are 5 and 6. 
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106.Use the Text Editor to find and edit the mt.conf file and delete everything that you 
copied into it except 5 and 6, Or whatever your tape drives are recognized with, then Save 
the file. 
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107.Use the Text Editor to find and edit the lb.conf file and delete everything that you 
copied into it except 4 or whatever your robot is recognized with and then Save and exit. 
This will take you back to the Console window. 

 

 

 

This completes the Configuration of the HBA 
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Step 9 
Modifying the .dtprofile file 

 

108.If Netscape has not been installed, insert the Netscape cd-rom and type the following 
at the command prompt: 

cd  /cdrom 

cd net* 

./installer 

 

109.Open a Text Editor window. 

 

 

 

110.The Text Editor window appears, click on File, Open, and double click on the 
.dtprofile file. 
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111.The Text Editor box now displays the information in the .dtprofile file. Arrow down 
to the bottom of the file and add the below information to the file and hit Enter.. 

 

 

 

112.Next, enter the below information at the bottom of the file. Once the information is 
Entered, Save and Close the window 

setenv PATH 
/opt/tivoli/tsm/server/bin:/opt/NSCPcom:/opt/tivoli/tsm/client/bin:$PATH 

 

113.Issue the below command to reboot the system for the changes to take effect.. 

 

 

 

This completes the modifying of the .dtprofile portion of the lab. 
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Step 10 
Setting up the Server GUI 

 

114. Load the server Command console window. 

 At the Command prompt, #, type: 

cd /opt/tivoli/tsm/server/bin hit Enter. 

./dsmserv hit Enter. 

  

 

 

115.The below window appears.  You may minimize this window, but do not close it. It is 
needed to run the Netscape GUI.  

Note: This is the Server Console window, which displays all commands running from 
the TSM GUI. You can use this to see what commands have been run. 

 

 

 

116.The below screen appears. Minimize all windows and open a Web browser by using 
the menu bar.  

Note: you may get a couple of error screens, ignore and close them. 
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117.The Web browser appears. Once you click on it, the below error windows appears. 
Click on OK: on both to continue. 

 

 

 

 

 

118.To log in, clear out the default URL and input the below information and hit Enter.  

http://localhost:1580/ 
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119.The Administrator Login window appears.  

Enter admin for both Userid and Password and click on submit. 
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120.The below warning message screen appears. Remove the check in the check box next 
to Show this Alert Next Time then click on Continue Submission. 

 

 

 
This completes the setting up of the Tivoli Storage Manager GUI portion of the 

lab.
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Step 11 

Remove the Default Client  
 

121.The Tivoli Server Administration window appears, click on the plus sign to the left of 
Object View, then the plus sign to the left of Client, click on the plus sign left of 
Client Node, click on Client Nodes, and on the right hand side of the screen, click on 
Client. 
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122.The Client Node Information window appears, click on Operations, then click on 
Remove this node.  

Note: The default client will be the only one listed. This node must be deleted to 
enable the deletion of the default policy domain later. 

 

 

 

123.The Remove this node: CLIENT Confirmation window appears, click on Finish. 
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124.The Operational Results window appears. Click on Return 

 

 

 

125.The Client Node window appears, this time there isn’t anything listed. 
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This completes the removal of the default client portion of the lab. 
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Step 12 
Setting up your server 

 

126.Set up your server with the below information.  

Note: IP addresses and Server names must be unique. 

Click on the plus sign to the left of Object View, then the plus sign to the left of 
Server, click on Server Status.  
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127.The Server Status window appears, click on the Operations button, on the pull-down 
menu, and enter the below information: 

Note: You will need to click on Finish and Return after each input. 

Set Server Name (eliminate the “_Server1” on the end) – simba 

Set server host name or IP address – Local Host IP “10.10.222.75” 

Set server TCP/IP Port number – 1500 

Set Server URL (http://<server>:1580) – http://10.10.222.75:1580 

Set Server password – admin 

Set Crossdefine – ON 

Set password expiration – 900 

Set web authentication time out – 0 

Set Activity Log retention – 7 
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This completes the configuration of your server portion of the lab. 
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Step 13  
Set up the Library 

 

128.Click on the plus sign to the left of Object View, if needed, then the plus sign to the 
left of Server Storage, then the plus sign to the left of Libraries and Drives, then 
Automated Libraries, and then Define Automated Library. 
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129.The Define Automated Libraries window appears, input the below information: 

Once complete, click on Finish and then Return. If you do not know the Device 
information, type  ls /dev/rmt at the command prompt and then input the information: 

Note: The information in the Device Field may be different. Check your 
configuration. 

Library Name – TL891 

Device Field – /dev/rmt/2lb 

 Shared Library – No  
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130.The Operation results window appears. Click on Return, if the operation states 
Finished. If not repeat steps 127 - 128. The system 

 

 

 

131.The system should now show the TL891 library that you created. 
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This completes the initial setup of the Library portion of the lab. 
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Step 14  
Setting up the Drives in the Library 

 

132.Click on the plus sign to the left of Object View, if needed, then the plus sign to the 
left of Server Storage, then the plus sign to the left of Libraries and Drives, if not 
already there, click on Automated Drives, then Operations, and then Define 
Automated Drive. 
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133.The Define Automated Drives window appears, input the below information then 
click Finish.  

Note: To find the element information for your library configuration, access the TSM 
Web site at:  http://www.tivoli.com/support/storage_mgr/requirements.html . At this 
URL, Select a Device Category and then look for your product. 

TL891 Drive 1 – 240 

TL891 Drive 2 – 241 

Choose the library previously defined – TL891 

Drive Name – TL891_DRV_1 

Device Name Field – /dev/rmt/0mt 

Element field – 240  

Device online – Yes 
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134.The Operation Results window appears, if failed, click Return and verify the 
information for steps 131 and 132, and try it again, if passed click Return and 
continue to the next step. 
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135.Once the tape drive information is accepted, you will need to repeat steps 131 – 133 
for each tape drive in the library. 

 

 

 

This completes the installation of the tape drives portion of the lab. 
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Step 15 
Setting up Device Class  

 

136.Click on the plus sign to the left of Object View, the plus sign to the left of Device 
Class, then click on DLT Device Classes, click on Operations, and then click on 
Define Device Class. 
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137.The Define Device Class Appears, input the below information and click on Finnish. 

Device Class Name – TL891Class 

Recording Format – Drive 

Library Name – TL891 

Mount Limit – Drives 

Mount Retention – 2 

Tape Volume Prefix – ADSM 

Mount Wait – 60 
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Installing and Configuring Tivoli Storage Manager 4.1.3 for Solaris 7 

Rev. 3.12 Q – 89 

138.The DLT Device Class window now shows the Device Class you created. 

 

 

 

This completes the setting up of the Device Class portion of the lab 
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Step 16 
Setting up the Storage Pools 

 

139.Click on plus sign to the left of Object View, the plus sign to the left of Server 
Storage, the plus sign to the left of Storage Pools, click on Sequential Access Storage 
Pools, click on Operations, and Define Sequential Access Storage pools. 
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140.The Define Sequential Access Storage Pools window appears, input the below 
information and click on Finish. 

Storage Pool Name – TL891SP 

Device Class – TL891CLASS 

Description – TL891 Storage Pool 

Media access Status – READ/WRITE 

Maximum Size Threshold – NOLIMIT 
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Next Storage Pool – “Left Blank” 

High Migration Threshold – 90 

Low Migration Threshold – 70 

Collocate? – No 

Reclamation Threshold – 60 

Maximum Scratch Volume Allowed – 999 

Delay Period for Volume Reuse – 0  

Reclamation to Storage Pool – “Left Blank” 

Migration Delay – 0 

Migration Continue – YES 

Overflow Location – “Left Blank” 
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141.The Sequential Access Storage Pools window appears, it now displays the Storage 
Pool you just created. 
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Step 17 
Setting up the Policy Domain Information 

 

142.Click on the plus sign to the left of Object View, then the plus sign to the left of Policy 
Domains, click on Policy Domain, then Operations, and then Define Policy Domain. 

Note: There is already a Standard Policy domain set up. Remove it before continuing 
to the next step. 
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143.The Define Policy Domain window appears, input the below information and then 
click on Finish and then Return. If fails, verify the information you are entering and 
try it again, if passes continue to step 31. 

Policy Domain Name – TL891PD 

Description – TL891 Policy Domain 

Backup Retention (Grace Period) – 30 

Archive Retention (Grace Period) – 365 
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144.The Policy Domain window now displays the Policy Domain you have just created.  

 

 

 

This completes the installation of the Policy Domain 
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Step 18 
Setting up the Policy Set Information 

 

145.Click on the Policy Domain that you created. The Policy Domain window appears 
with detailed information about this Policy Domain. Click on Policy Sets at the 
bottom of the window, click on Operation, and then Define Policy Set. 
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146.The Define Policy Set window appears, input the below information and then click on 
Finish and then Return. If fails, verify the information you are entering and try it 
again, if passes continue to the next step. 

Policy Domain Name – TL891PD 

Policy Set Name – TL891PS 

Description – Policy Set for TL891 

 

This completes the setting up of the policy set portion of the lab. 
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Step 19 
Setting up the Management Classes 

 

147.The Policy Set window now displays the Policy Set that you just created. Click on the 
policy set that you created, then Management Classes, then Operations, and Define 
Management Classes. 
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148.The Define Management Classes Window appears, input the below information and 
then click on Finish and then Return. If fails, verify the information you are entering 
and try it again, if passes continue to step 36. 

Policy Domain Name – TL891PD 

 Policy Set Name – TL891PS 

 Mgmt Class Name – TL891MC 



Designing and Implementing HP Enterprise Backup Solutions 

Q – 102 Rev. 3.12 

Description – Management Class For TL891 

Space Management Technique – NONE 

Auto-Migrate on Non-Use – 0 

Migration Requires Backup – Yes 

Migration Destination – TL891SP 

 

 

 

149.The Management Class window appears, it displays the Management Class you 
created. Click on the management class, then Operations, then Assign as Default 
Management Class, then Finish and then Return. 
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This completes the creation of the Management Classes portion of the lab. 
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Step 20 
Defining the Backup Copy Group 

 

150.The Management Classes window appears it now shows the Management Class you 
just created. Click on the Management Class you created, then Backup Copy Groups, 
then Operations, then Define Backup Copy Group. 

 



Installing and Configuring Tivoli Storage Manager 4.1.3 for Solaris 7 

Rev. 3.12 Q – 105 

 

 

151.The Define Backup Copy Group window appears, input the below information and 
click Finish and Return. If fails, verify the information you are entering and try it 
again, if passes continue to the next step. 

Policy Domain Name – TL891PD 

 Policy Set Name – TL891PS 

Mgmt Class Name – TL891MC 
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Copy Destination – TL891SP 

Copy Frequency – 0 

Version Data Exists – 2 

Version Data Delete – 1 

Retain Extra Version – 30 

Retain Only Version – 60 

Copy Mode – Modified 

Copy Serialization – SHRSTATIC 

 

 

 

152.The Backup Copy Groups Windows appears, it now displays the Backup Copy Group 
they you created. 
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This completes the Defining of the Backup Copy Group portion of the lab. 
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Step 21 
Audit the Library 

 

153.Click on Object View, Server Storage, Library and Drives, Automated Libraries, The 
Library you defined, Operations, and then Audit Library. 
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154.The Audit Library window appears, Verify that YES is selected for Check Labels, then 
click Finish, and then Return. 
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This completes the Audit the Library portion of the lab. 
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Step 22 
Labeling the Library Volume 

 

155.The Audit Library window appears, it displays the information about the library. 
Click on Object View, then Server Storage, then Library and Drives, then Library 
Volumes, then Operations, and then Label Library Volume. 
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156.The Label Library Volume window appears, input the below information and click on 
Finish and then Return. 

Library Name – TL891 

Volume Name –  “Leave Blank” 

Search Library – YES 

Source for Library – BARCODE 
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Library Category for Volume – SCRATCH 

Device Type – “Leave Blank” 

Over-write existing Label – YES 

Volume Range – “Leave Blank” 

Volume List – “Leave Blank” 

 

 

 

157.The Library Volumes Window appears, with no objects found. 
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This completes the Labeling of the Library Volume portion of the lab. 
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Step 23 
Setting up the Client Node Information  

 

158.Click on the plus sign to the left of Object View, the plus sign to the left of Clients, 
click on Client Nodes, then Operations, and then Register a New Node. 
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159.The Register a New Node window appears, input the below information then click on 
Finish and then Return. 

Node Name – TL891NODE “Name it what you want” 

Password – admin  

Contact – “Leave Blank” 

Policy Domain Name – TL891PD 

Client Compression Settings – NO “Tape devices already have their own 
compression.” 

Archive Delete Allowed – YES 

Backup Delete Allowed – NO 

Client Option SET – “Leave Blank” 

Force Password Reset – NO 

Node Type – Client  

Keep Mount Point – NO 

Maximum Mount Points Allowed – 2  

URL – http://client.host.name:1581 

User ID for Remote Access - “Leave Blank” 

Password Expiration Period - “Leave Blank” 
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160.Click on Object View, then Policy Domains, then Policy Sets, then The defined Policy 
Set, then Operations, then Validate Policy Set, then Finish and then Return. 
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Installing and Configuring Tivoli Storage Manager 4.1.3 for Solaris 7 

Rev. 3.12 Q – 119 

161.Click on Operations, then Activate Policy Set, then Finish and then Return. 

 

 

 

This completes the Setting up of the Client Node portion of the lab. 
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Step 24 
Running the dsmcad file in the background 

 

162.Open a Console Window and go into the /opt/tivoli/tsm/client/ba64/bin directory. 

 

 

 

163.Run the dsmcad file and place it into memory by running the below command. Once 
ran, you can Minimize or close the window and go back to the Netscape Navigator 
window. 

Note: If you minimize the window, you will be able to go back and view the actual 
command lines needed to perform the various tasks, Backup, Restore. Etc. 

 

 

 

This completes the running of the dsmcad service in the background 
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Step 25 
Install and configure the Web client from the 

command line 
 

164.Open up a notepad session by clicking on the notepad icon on the task bar 

 

 

 

165.The Notepad window appears, maximize it, then click on file, open and follow the 
following path, /opt/tivoli/tsm/client/ba64/bin and double-click the dsm.sys file. 
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166.The information in the dsm.sys file is shown. Add the below information, exactly as 
shown, to the file above and below the information under the *****. Then save and 
close the window. 

Above – Servername simba I used simba, your name will be different. 

Below – passwordaccess generate – all lower case 

 

 

 

167.The Command prompt, #, appears Generate the TSM password, start a native backup-
archive client. 

At the command prompt, #, type dsmc query session 

 

 

 

168.The system will ask you to Please Enter your user id <simba>:Type your user id 
“simba for my lab” and hit Enter. 

 

 

 

169.The system will ask you to Please Enter your password for user id <simba>:Type 
your password “client” and hit Enter. 
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170.Quit the native TSM backup-archive client. 

 

171.Start the client acceptor service. 

At the command prompt type dsmcad and hit enter. 

 

 

 

172.Load Netscape.  

At the command prompt, #, type the below commands and hit Enter after each. 

 

 

 

173.The Netscape window appears, enter the below url into the url address and hit enter. 

http://your_machine_name:1581 “my lab I used simba” 
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Installing and Configuring Tivoli Storage Manager 4.1.3 for Solaris 7 

Rev. 3.12 Q – 125 

174.The Netscape Tivoli Storage manager window appears, click on the backup button. 
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175.The TSM login window appears, type your user id, I used simba, and type in your 
Password, I used client, then click on Login.  

 

 

 

This completes the installation and configuration of the Web client from the 
command line portion of the lab. 



Installing and Configuring Tivoli Storage Manager 4.1.3 for Solaris 7 

Rev. 3.12 Q – 127 

Step 25 
Run a Backup 

 

176.The backup screen will appear, find and select a directory to backup. Once selected 
click on the Backup button on the task bar. 
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177.The Task List window appears. It displays the files that are being backup up and the 
size of each. 

 

 

 

178.Once the backup is complete, the TSM message window appears, click on OK 
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179.The Backup report window appears, review it for errors then close it. 

 

 

 

This completes the backup portion of the lab 
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Step 26 
Run a Restore 

 

180.The Netscape Tivoli Storage manager window appears once more. Open up a File 
Manager Window and delete the File you just backed up. Once removed, close the 
window and click on Restore. 
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181.The Restore Window appears, find and select the directory you want to restore then 
click on the Restore button on the task bar. 

 

 

 

182.The restore Destination window appears, Verify that Original Location is selected and 
click on Restore located at the bottom of the window. 

 

 

 



Designing and Implementing HP Enterprise Backup Solutions 

Q – 132 Rev. 3.12 

183.The Restore Report window appears it lists the files being restored. 

 

 

 

184.Once the restore is complete, the TSM message window appears. Click on OK. 
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185.The Restore Report window appears, close it. 

 

 

 

186.Open a file Manager window and verify that the file you deleted earlier is now 
restored. Once complete, close file manager. 
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This completes the Restore portion of the Lab 
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Step 27 
Uninstalling TSM 

 

187.Determine the Tivoli Subsets installed on your system. 

At the command prompt, #, type  

pkginfo | grep TIV 

 

 

 

188.The below information appears. 

 

 

 

189.Remove your version of Tivoli Software 

At the command prompt, #, type the below command and hit Enter. 
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190.The below screen appears, type y and hit Enter. 

 

 

 

191.The below screen appears, type y and hit Enter. 

 

 

 

192.The below screen appears, type y and hit Enter. 

 

 

 

193.The below screen appears, type y and hit Enter. 
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194.The below screen appears, type y and hit Enter. 

 

 

 

195.The below screen appears, type y and hit Enter. 

 

 

 

196.The below screen appears, type y and hit Enter. 

 

 

 

197.The below screen appears, type y and hit Enter. 
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198.The below screen appears, type y and hit Enter. 

 

 

 

199.The below screen appears. 

 

 

 

This completes the removal of Tivoli Storage Manager portion of the lab 

 

 




